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Safety summary 1

The following general safety precautions must be observed during all phases of 
operation, service and repair of this equipment. 

Failure to comply with these precautions or with specific warnings elsewhere in this 
manual violates safety standards of design, manufacture and intended use of the 
equipment. Thrane & Thrane A/S assume no liability for the customer's failure to 
comply with these requirements.

Do not operate in an explosive atmosphere
Do not operate the equipment in the presence of flammable gases or fumes. 
Operation of any electrical equipment in such an environment constitutes a definite 
safety hazard.

Keep away from live circuits
Operating personnel must not remove equipment covers. Component replacement 
and internal adjustment must be made by qualified maintenance personnel. Do not 
replace components with the power cable connected. Under certain conditions, 
dangerous voltages may exist even with the power cable removed. To avoid injuries, 
always disconnect power and discharge circuits before touching them.

Do not service alone
Do not attempt internal service or adjustments unless another person, capable of 
rendering first aid resuscitation, is present.

Do not substitute parts or modify equipment
Because of the danger of introducing additional hazards, do not substitute parts or 
perform any unauthorized modification to the equipment.

Keep away from active antenna front
This device emits radio frequency energy when switched on. To 
avoid injury, keep a minimum safety distance of 0.6 m from the 
antenna front when the EXPLORER™ 300 is on. See also the 
below section Antenna safety instructions.

Only use approved batteries from Thrane & Thrane
Use of non approved batteries may result in explosion, fire, electrical shock or injury. 

Observe marked areas
Under extreme heat conditions do not touch areas of the 
EXPLORER™ 300 that are marked with this symbol, as it may 
result in injury. 
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Antenna safety instructions
Antenna safety instructions 2

Use only manufacturer supplied antennas

Antenna minimum safe distance: 60 cm

Antenna gain

Directional, with maximum gain of 11.1 dB reference to isotropic.

The Federal Communications Commission has adopted a safety standard for human exposure to RF (Radio 
Frequency) energy which is below the OSHA (Occupational Safety and Health Act) limits.

Antenna mounting

The antenna supplied by the manufacturer must be located such that during radio transmission, no person or 
persons can come closer than the above indicated minimum safe distance to the antenna, i.e. 60 cm.

To comply with current FCC RF Exposure limits, the antenna must be installed at or exceeding the minimum 
safe distance shown above, and in accordance with the requirements of the antenna manufacturer or 
supplier.

Antenna substitution

Do not substitute any antenna for the models supplied or recommended by the manufacturer. You may be 
exposing people to excess radio frequency radiation. You may contact the manufacturer for further 
instructions.

Radiation warning

You, as the qualified end-user of this radio device, must control the exposure conditions of bystanders to 
ensure the minimum separation distance (above) is maintained between the antenna and nearby persons, 
for satisfying RF Exposure compliance. The operation of this transmitter must satisfy the requirements of 
Occupational/Controlled Exposure Environment, for work-related use. Only use the terminal when persons 
are at least the minimum distance from the front face of the antenna.

WARNING! Maintain a separation distance of at least 60 cm from the front face of the 
antenna to a person.
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About this manual
About this manual 3

Intended readers

This manual is a user manual for the EXPLORER™ 300. The readers of the manual include anyone who is 
using or intends to use the EXPLORER™ 300. No specific skills are required to operate the EXPLORER™ 300. 
However, it is important that you observe all safety requirements listed in the Safety summary and in the 
Antenna safety instructions in the beginning of this manual, and operate the EXPLORER™ 300 according to 
the guidelines in this manual. 

Manual overview

This manual has the following chapters:

• Introduction contains an overview of the BGAN services and a brief description of the system.

• Getting started explains how to insert SIM card and battery, start up the unit, point the antenna and enter 
the PIN. It also contains a short guide to making the first call.

• Using the display and keypad contains an overview of the display menu system and explains how to use 
the menus.

• Using the interfaces goes through the basic setup and use of each interface.

• Using the web interface explains how to use the built-in web interface of the EXPLORER™ 300, and 
describes the available menus and settings. It also explains advanced setup of interfaces with the web 
interface.

• Maintenance and troubleshooting contains a short troubleshooting guide and explains how to update 
software. It also describes and lists the alarm messages that may appear in the handset, and gives 
information on where to get further help if necessary.

Typography

In this manual, typography is used as indicated below:

Bold is used for the following purposes:

• To emphasize words. 
Example: “Do not touch the antenna front during pointing”.

• To indicate what the user should select in the user interface. 
Example: “Select Settings > Interfaces > Bluetooth and click Enabled”. 

Italic is used to emphasize the paragraph title in cross-references. 
Example: “For further information, see Connecting Cables on page...”.

COURIER is used for the following purposes:

• To indicate text appearing in the display. 
Example: “the Main screen shows READY”.

• To indicate low level commands such as AT commands. 
Example: “In your terminal program, type ATD”.
TT 98-123571-DraftA v
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Chapter 1
Introduction 1

Welcome

Congratulations on the purchase of your EXPLORER™ 300!

The EXPLORER™ 300 is the smallest and most compact BGAN terminal in the EXPLORER™ family. 
It is a broadband mobile terminal with integrated antenna, providing high-speed data and voice 
communication via satellite through the Broadband Global Area Network (BGAN).

Just plug in a phone, laptop or PDA, or use the Bluetooth® interface, point the antenna towards 
the BGAN satellite - and you are online.

The flat, light-weight design of the EXPLORER™ 300 makes it easy to carry e.g. in the front pocket 
of a laptop bag. 

Applications include:

• Internet browsing

• E-mail

• Phone services

• Large file transfers

• Video conferencing and Streaming

• VPN (Virtual Private Network) access to corporate servers

In this chapter

This chapter gives an overview of the BGAN system and services, and introduces the 
EXPLORER™ 300.

It also gives an overview of the physical unit and its features and functions.
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Chapter 1: Introduction
The BGAN system

What is BGAN?

The Broadband Global Area Network (BGAN) is a mobile satellite service that offers high-speed 
data up to 492 kbps and voice telephony. BGAN enables users to access e-mail, corporate 
networks and the Internet, transfer files and make telephone calls.

Coverage

The Inmarsat® BGAN services are based on geostationary satellites situated above the equator. 
Each satellite covers a certain area (footprint). The coverage map below shows the footprints of the 
BGAN system.

Note The map depicts Inmarsat's expectations of coverage, but does not represent a 
guarantee of service. The availability of service at the edge of coverage areas fluctuates 
depending on various conditions.

The launch of the F-3 satellite will be determined in due course.
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Chapter 1: Introduction
Overview of the BGAN system

A complete BGAN system includes the EXPLORER™ 300 with connected peripherals, the BGAN 
satellite, and the Satellite Access Station (SAS). The satellites are the connection between your 
EXPLORER™ 300 and the SAS, which is the gateway to the worldwide networks (Internet, 
telephone network, cellular network, etc.).

Satellite
IP Router

PC

Satellite Access Station
(SAS)

Switch Voice and ISDN

LaptopBluetooth
handset

Circuit Switched Network

Packet Switched Network

EXPLORERTM 300
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Chapter 1: Introduction
The BGAN services

Supported services

This section describes the services available with BGAN. Note that not all of these services are 
available in the EXPLORER™ 300. See Features and interfaces of the EXPLORER™ 300 on page 5.

The services currently supported by BGAN comprise:

• A Packet Switched connection to the Internet

• A Circuit Switched (Dialed) connection for voice, fax or data

• Short Messaging Service (SMS)

Packet data service

The BGAN network supports different classes of data connection to the Internet. 

• Using a Standard data connection, several users can share the data connection 
simultaneously. This type of connection is ideal for e-mail, file transfer, and Internet and 
intranet access. The user pays for the amount of data sent and received.

• Using a Streaming data connection, you get an exclusive, high-priority connection, ensuring 
seamless transfer of data. This type of connection is ideal for time critical applications like live 
video over IP. The user pays for the duration of the connection (per minute charge).

Circuit switched (dialed) service

Two types of circuit switched connection are available:

• Standard Voice. A low-tariff connection for voice only. The voice signal is compressed to 
4.0 kbps, which reduces the bandwidth use and consequently the tariff.

• 3.1 kHz Audio. A high quality connection which can be used for Premium Voice, G3 fax, 
analog modem or ISDN. 
The signal is uncompressed 3.1 kHz audio, which allows for optimum voice quality.

SMS service

The BGAN system provides a Short Messaging Service (SMS) for sending and receiving SMS 
messages.

Supplementary services

The BGAN system also provides the following supplementary services:

• Call hold

• Call waiting

• Call forwarding

• Voice mail

• Call barring (using AT commands)
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Chapter 1: Introduction
Features and interfaces of the EXPLORER™ 300

Features

 The EXPLORER™ 300 provides the following features:

High speed data up to 384 kbps - shared bandwidth

Support for Streaming classes 32 and 64 kbps 

Simultaneous voice and data

Standard LAN, Bluetooth and phone ports

Built-in web interface allowing you to manage your phone book, messages and calls, and 
customize the terminal to your specific needs 

100-240 V AC power adapter

Lightweight and portable design

Easy setup and use 

Robust and durable design

CE, FCC and GMPCS certified
TT 98-123571-DraftA 5



Chapter 1: Introduction
Overview of interfaces

The EXPLORER™ 300 provides interfaces for connection of a phone or a computer. 

Using the interfaces on page 47 describes how to use each of the available interfaces.

Minimizing power consumption

The EXPLORER™ 300 is designed for minimum power consumption. This means that functions that 
are not currently used will automatically go into a “sleep mode” to minimize the power 
consumption.

In addition to this automatic sleep mode function, you can disable each of the interfaces if they are 
not currently used. Note, however, that you will not be able to use these interfaces until you 
enable them again. For information on how to enable/disable interfaces, see Enabling or disabling 
an interface on page 49.

LAN

LAN

Standard Phone
Connection

Bluetooth
TT 98-123571-DraftA 6



Chapter 1: Introduction
Your EXPLORER™ 300 terminal

Overview

The EXPLORER™ 300 is a compact unit comprising antenna, compass, display and keypad, all in 
one unit.

Display and keypad

The EXPLORER™ 300 has a display and a keypad for displaying status and for changing simple 
parameters.

For information on how to use the keypad and display, and for an overview of the display menu 
system, see Using the display and keypad on page 30.

Display and keypad

Antenna

Compass

Power indicator

Power button

Keypad

Display

Message indicator
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Chapter 1: Introduction
Light indicators

The EXPLORER™ 300 has two light indicators next to the display: a green power indicator and a 
red message indicator.

Green Power indicator
The function of the green Power indicator to the left of the display is as follows:

Red Message indicator
The function of the red Message indicator is as follows:

Behavior of green indicator Meaning

Short flash every 2 seconds The EXPLORER™ 300 is on.

Steady light The battery is charging.

Flashing rapidly A charging error has occurred.

For further information, refer to the Troubleshooting Guide on 
page 116.

Off No power or Stealth mode.

Behavior of red indicator Meaning

Flashing An alarm is active or

An SMS message has arrived.

Press OK on the keypad to view the alarm(s) or SMS 
message(s).a

The red light will keep flashing after OK is pressed if

• there are more SMS messages, or

• an alarm is still active. 
For information on alarm messages, see Alarm messages 
on page 122.

a. If a computer is connected, you can also view alarms and SMS messages in the built-in web interface in the
EXPLORER™ 300. For further information, see Icons in the icon bar on page 70.

Off No messages are present, or the EXPLORER™ 300 is in Stealth 
mode.
TT 98-123571-DraftA 8



Chapter 1: Introduction
User interfaces

The keypad and display are used for pointing the antenna, for displaying status and for changing 
simple parameters.

To obtain full access to all features and for ease-of-use, you should use a computer 
(a PC, Laptop or similar) and one of the following:

• The web interface. A built-in web interface for easy configuration and daily use. The web 
interface is accessed from a computer connected to the EXPLORER™ 300, using an Internet 
browser. For further information, see Chapter 5, Using the web interface.

• The BGAN LaunchPad from Inmarsat. BGAN LaunchPad is a computer application used to 
control terminals in the BGAN system. LaunchPad is provided on the Inmarsat BGAN CD-ROM 
supplied with your EXPLORER™ 300. For information on how to use the LaunchPad, refer to 
the manual on the Inmarsat CD-ROM.

Additionally, it is possible to control the EXPLORER™ 300 using AT Commands. Refer to 
Appendix B, AT commands.

Antenna

The white part of the EXPLORER™ 300 is the antenna module. The antenna module comprises a 
GPS (Global Positioning System) antenna, a BGAN antenna and a Bluetooth antenna. 

Compass

The EXPLORER™ 300 also provides a compass to help positioning the 
antenna. For further information on how to use the compass, see 
Pointing the antenna on page 21.

Battery

The EXPLORER™ 300 comes with a rechargeable battery, which is easily inserted. The battery is 
automatically recharged when power is applied to the EXPLORER™ 300. Steady green light 
indicates that the battery is charging.

SIM card

The SIM (Subscriber Identity Module) card used for the EXPLORER™ 300 is a standard SIM card, 
which is acquired from the Airtime Provider. 

The EXPLORER™ 300 requires a SIM card to go online and to access the settings of the 
EXPLORER™ 300. Without a SIM card you can only see the Main screen of the display system 
showing battery status etc. Using the web interface, you can view the properties of the 
EXPLORER™ 300 and upload software without inserting a SIM card. Upload of software, however, 
requires an Administrator user name and password.
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Chapter 1: Introduction
Matrix of services and communication interfaces

The following table shows which services can be accessed from which interfaces, and which types 
of equipment can be used.

What’s next?

This chapter has provided an overview of the BGAN system and of the EXPLORER™ 300. 

The next chapters will go into more detail about how to set up and use the EXPLORER™ 300. The 
following chapter, Getting started, explains how to unpack and start up the EXPLORER™ 300, and 
how to point the antenna in order to get the best possible signal. 

Service

Interface on the EXPLORER™ 300

Phone Bluetooth LAN
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Keypad
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Chapter 2
Getting started 2

In this chapter

This chapter describes:

• what is included in the delivery,

• how to insert and remove the battery and SIM card, and

• how to start up the EXPLORER™ 300 and make the first call or data session.

Unpacking and assembling

Unpacking

Unpack the EXPLORER™ 300 and accessories and check that the following items are present:

EXPLORER™ 300 

LAN Cable

AC/DC adapter

EXPLORER™ 300 Battery

Getting Started Kit

- Getting Started leaflet
- Quick Guide
- EXPLORER™ 300 CD-ROM
- BGAN LaunchPad CD-ROM

containing:
TT 98-123571-DraftA 11



Chapter 2: Getting started
Inserting the SIM card

The EXPLORER™ 300 is delivered with the battery separated from the terminal. If the battery is 
already inserted, remove it as described in Removing the battery on page 13.

The SIM card is provided by your Airtime Provider. Insert the SIM card as follows:

1. Insert the SIM card into the SIM slot. Make 
sure the SIM card is positioned as shown!

2. Press gently until it clicks.

3. Slide the lock to close the SIM slot.

Inserting the battery

Do as follows:

1. Insert the battery. 
Make sure the battery is positioned correctly as 
shown.

2. Press gently until it locks.

Note Before using the terminal the first time: To ensure accurate information on the battery 
capacity you should fully charge, then fully discharge the battery (until the 
EXPLORER™ 300 closes down automatically), and finally recharge the battery. The 
EXPLORER™ 300 can be used during the discharging process, but the remaining battery 
capacity may not be displayed correctly. 
For information on how to recharge the battery, see Recharging the battery on page 113.
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Chapter 2: Getting started
Removing the battery

To remove the battery, do as follows:

1. Locate the slide lock at the bottom of 
the unit.

2. Slide the lock aside to release the 
battery from the unit.

3. Remove the battery.
TT 98-123571-DraftA 13



Chapter 2: Getting started
Removing the SIM card

To remove the SIM card, first remove the battery as described in Removing the battery on page 13.

Remove the SIM card as follows:

1. Slide the lock aside to open the SIM 
slot as shown.

2. Gently press the SIM card and let it 
pop out of the slot.

3. Remove the SIM card.

Note When the SIM card is removed, you cannot use the display menu system nor make calls 
or start data sessions.
Only emergency calls are allowed, and only if permitted by the network.

However, if you have an administrator user name and password, you can upload 
software using the web interface. For further information, see Uploading software on 
page 113.
TT 98-123571-DraftA 14



Chapter 2: Getting started
Connecting cables

After inserting SIM card and battery, connect all relevant cables.

Side connector panel

The connector panel is placed on the side of the EXPLORER™ 300 and has the following 
connectors:

• Phone connector for connecting a 
standard phone

• LAN connector for data equipment 

• DC Power connector (10-16 V DC) for 
connection to a 100-240 V AC/DC 
adapter, or to a charger cable which 
connects to the cigarette lighter 
socket/12 V DC in a car.

For information on how to connect to a specific interface, see the corresponding section in 
Chapter 4, Using the interfaces. The end of this section describes how to connect to power.

Rear connector

Apart from the connectors in the connector panel, 
the EXPLORER™ 300 has a connector placed on the 
rear side of the EXPLORER™ 300.This connector is 
marked DC OUT and is used for charging the 
EXPLORER™ Bluetooth Handset.

For information on how to connect to the Bluetooth 
charger interface, see Using the EXPLORER™ 
Bluetooth Handset charger on page 66.

Before connecting to power

You can connect to external power or use the battery delivered with your EXPLORER™ 300.

Refer to Power input on page 130 for specifications and pin-out for the DC Power input.

If you are connecting to a 100-240 V AC electrical outlet, use the AC/DC adapter included with your 
EXPLORER™ 300. 

Alternatively, you may connect to 12 V DC in a car.

Important Connect the cables before making the final adjustment of the antenna position. 
Otherwise you may accidently move the antenna when you connect the cables.

Phone     LAN     DC Power

Illustration of DC OUT connector
at the back of the terminal
TT 98-123571-DraftA 15



Chapter 2: Getting started
Connecting to power

You can connect the DC input to power without the battery inserted. 

If the battery is inserted when you apply power to the EXPLORER™ 300, the battery is 
automatically recharged. 

Connecting to a 100-240 V AC electrical outlet: Connect the AC/DC adapter to the DC Power input 
on the side of the EXPLORER™ 300. Then connect the power cable between the 100-240 V AC 
electrical outlet and the AC/DC adapter. 

Connecting to 12 V DC in a car: Connect the charger cable between the DC Power input of the 
EXPLORER™ 300 and the cigarette lighter socket in the car. A suitable charger cable is available 
from Thrane & Thrane.
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Powering the EXPLORER™ 300

Automatic power up

The default behavior of the EXPLORER™ 300 is to power up automatically when you connect the 
power cable. If you wish, you can change this power up mode, so that the EXPLORER™ 300 is only 
powered if the Power button is pressed.

For further information on power up mode, see Setting the power up mode on page 41 or Power up 
behavior on page 85.

Switching the EXPLORER™ 300 on/off

To switch on the EXPLORER™ 300, push 
the Power button next to the display and 
hold it down until the green Power 
indicator lights up. It normally takes one 
or two seconds.

To switch off the EXPLORER™ 300, push the Power button again and hold it until the display 
shows SWITCHING OFF....
  

After switching on the EXPLORER™ 300 you will be 
prompted for a PIN (Personal Identification Number), 
unless the PIN is disabled (e.g. using the BGAN 
LaunchPad). 

For information on the options after power on, see the next section.

WARNING! When the EXPLORER™ 300 is powered on, stay clear of the antenna 
front! The antenna emits radio frequency energy, not only when the display shows 
DATA ACTIVE. Always keep a minimum distance of 0.6 m from the antenna front.

Power

Power
Indicator

Button
TT 98-123571-DraftA 17



Chapter 2: Getting started
Options for the start-up procedure

Overview of the start-up options

You have different options for the start-up procedure. Each of these options are briefly described 
in this section.

For information on how to enter PIN and point the antenna, see the subsequent sections.

The following drawing shows the options available after power on.

The numbers on the drawing refer to the different start-up options described in the following 
sections.

Note If the use of PIN is disabled, e.g. from the BGAN LaunchPad, the display sequence is the 
same as after successfully entering the PIN. This means that after power on, you will see 
the Signal strength screen. 

Power on

ENTER PIN?
Cancel         OK

  ENTER PIN
 *-

"Signal Strength"
Cancel          OK

"Signal Strength"
Cancel          OK

"Main screen" "Main screen"

You can access the
menu system but you
cannot use the BGAN
network.

You can access the
menu system and use
the BGAN network.

"Main screen"

You cannot access the
menu system, and you
cannot use the BGAN
network.

"Main screen"

You cannot access the
menu system, and you
cannot use the BGAN
network, except for
emergency calls, if
allowed by the network.

Menu system Menu system

12

3
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“Full” procedure (1)

After power on, enter the PIN and then point the antenna. 

In this mode you have full access to the EXPLORER™ 300, that is you can use the menu system and 
communicate on the BGAN network.

The display will show READY when the menu system is not activated.

“Off-line” procedure (2)

After power on, enter the PIN, but cancel pointing. 

In this mode you can use the menu system, but are not able to communicate on the BGAN 
network.

The display will show POINT NOW? when in the Main screen.

Press  or  to enter the menu system.

When you want to point the antenna, press OK from the Main screen. 

“Emergency” procedure (3)

After power on, cancel the PIN and then point the antenna. 

In this mode you can only place emergency calls, and only if permitted by the network. You are not 
able to access the menu system nor to communicate on the BGAN network (apart from emergency 
calls), until you enter the PIN.

The display will show ENTER PIN?
If you press OK you can enter the PIN. No other options are available from the keypad.

From the web interface you can view properties and, if you have an administrator password, 
upload software.
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Entering the SIM PIN

Overview

You have to enter a PIN to use the EXPLORER™ 300, unless the use of PINs is disabled e.g. from 
the BGAN LaunchPad. 

The first time you are asked for a PIN, you can choose to cancel (press C). If you cancel, you are 
asked again after pointing is completed. At that point you must enter the PIN to be able to 
continue.

Entering the PIN

To enter the PIN using the display and keypad, do as follows:

1. When you are asked for a PIN, press OK. 
  

2. Press  or  a number of times until the 
first digit is correct. 

3. Press OK to go to the next digit. 
When OK is pressed, the previous digit is 
indicated by a *.

To correct an entered digit, press C to go back and use the  and  buttons again.

4. After entering the last digit with OK, press OK again to apply the PIN. 

For further information, see Using the display and keypad on page 30.

You can enter the PIN using a phone or computer connected to the EXPLORER™ 300. For further 
information, see Entering the SIM PIN using a phone on page 53 or Entering the SIM PIN in the 
web interface on page 71.

Wrong PIN

You have 3 attempts to enter the PIN, before you are asked to enter the PUK (Pin Unblocking Key). 
The PUK is supplied with your SIM card. 
Enter the PUK followed by a new PIN of your own choice. The PIN must be from 4 to 8 digits long.

Note At this point the EXPLORER™ 300 may make a sound. This sound is used for pointing the 
antenna. To toggle the pointing sound on/off, press  or .

Important If you enter a wrong PUK 10 times, the SIM card will no longer be functional, and 
you have to contact your Airtime Provider for a new SIM card.
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Pointing the antenna

The importance of pointing

In order to obtain the best possible signal at the lowest 
possible cost, it is important that the EXPLORER™ 300 
antenna is pointed correctly towards the satellite.  

The antenna must have a clear line of sight to the 
satellite without any obstacles blocking the signal, and 
the pointing direction of the antenna should be as 
accurate as possible.

The next sections describe how to point the antenna for the best possible signal.

Pointing data

If the position of the satellite in relation to the EXPLORER™ 300 is known, you can use the 
compass to roughly point the antenna in the right direction. If you know the Azimuth and the 
Elevation, you can use this data to adjust the antenna.

• The Azimuth is the horizontal rotation angle relative to 
North (moving clockwise).

• The Elevation is the vertical rotation angle relative to 
horizontal. This means that an Elevation of 0° 
corresponds to the EXPLORER™ 300 being in an upright 
position, pointing towards the horizon.

The compass has 7 lines dividing the Elevation scale into 6 
spaces. The space between two lines corresponds to 15°.

The Elevation is measured where the lines meet. This compass 
shows an Elevation of 30° (2 spaces up from the first line) and 
an Azimuth of 270° (antenna pointing towards West).

Important Incorrect pointing may result in poor quality of the signal, and in some cases 
retransmission may be necessary. This could mean you will be paying more than 
necessary for your transmission.

Note The above explanation assumes that the compass shows the exact orientation. Please 
take into consideration the possible deviation and variation that can occur, e.g. because 
of the geographical location or the presence of magnetic objects. 

N = 0°

S = 180°

E = 90°W = 270°

Front of antenna
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Required signal strength

As a rule of thumb, the signal strength should typically be 41 dBHz or more for the 
EXPLORER™ 300 to be able to establish a call or data session. However, the required signal 
strength can vary depending on a number of factors, such as weather conditions and location.

Do not block the antenna signal with your hands

Obtaining a GPS fix

The EXPLORER™ 300 must acquire its own location from the GPS satellites before it can register 
on the BGAN network. This is called obtaining a GPS fix.

If the antenna is placed in an open location with a wide view to the sky, the EXPLORER™ 300 will 
probably obtain the GPS fix automatically while you are pointing towards the BGAN satellite.
However, if part of the view to the sky is blocked, and/or the Elevation is very low, it may 
sometimes be difficult for the GPS antenna to “see” a sufficient number of GPS satellites. In such 
circumstances, try the following:

1. Place the antenna flat on an even surface, pointing straight upwards with a clear view to as 
much of the sky as possible.

2. When the GPS fix is obtained, you can start pointing towards the BGAN satellite.
To see the GPS status, enter the display menu system by pressing  or  and select
PROPERTIES > GPS STATUS. For further information, see Viewing the GPS status on 
page 42.

Important When pointing the antenna, do not touch the front of the antenna module. For your 
safety, always maintain a distance of minimum 60 cm from the front face of the 
antenna. Also, if you place your fingers on the antenna you will be blocking the 
signal, and the antenna will not work efficiently.

Hold the support bracket and the battery module below the antenna while pointing.
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Pointing the antenna towards the satellite

To help you obtain the best possible signal strength, the EXPLORER™ 300 uses a pointing sound 
to indicate the signal strength during pointing. The frequency of the tone increases with the signal 
strength.

You can toggle the pointing sound on/off by pressing  or on the keypad.

Do as follows to point the antenna:

1. While observing the built-in compass of the 
EXPLORER™ 300, rotate the 
EXPLORER™ 300 left or right until it points in 
the correct horizontal direction, known as 
the Azimuth. Refer to Pointing data on 
page 21.  
Hold the battery module and the support 
bracket while moving the antenna. Do not 
place your hands on the antenna.

2. Tilt the EXPLORER™ 300 slowly up or down 
until it points in the correct vertical direction, 
known as the Elevation. 
Hold the battery module and the support 
bracket while moving the antenna. Do not 
place your hands on the antenna.

3. After passing the PIN screen, the display 
shows the current satellite signal strength. Use 
this information to fine-adjust the antenna 
position as shown in step 1 and 2.  
Remember not to touch the antenna part!

If the right most part of the signal strength bar is grey, it indicates that the level has previously 
been higher than the current level.

Important When fine-adjusting the antenna, the display may take a while to update the 
signal strength. Wait a second or two after each move to make sure the display 
is updated.
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4. When you have the highest signal strength you 
can obtain, press OK on the keypad. 

The EXPLORER™ 300 now tries to establish a connection to the BGAN network.
The display shows the progress as follows:

• SEARCHING: 
The EXPLORER™ 300 searches for the network operator. Note that the search procedure 
can be very short, so you may not see this text.

• REGISTERING: 
The EXPLORER™ 300 is registering itself on the network.
If the GPS position has not yet been acquired at this point, the display will show
NO GPS. For further information, see the Troubleshooting Guide on page 117.

• READY or DATA ACTIVE: 
READY means the EXPLORER™ 300 is registered on the network and is ready to go online. 
If you have already connected a computer, the display shows DATA ACTIVE instead of 
READY.

CANCEL: If you press C instead of OK, you exit the pointing menu and the display shows the Main 
screen with the message POINT NOW?. 
If the PIN has been accepted, you now have access to the menu system, but you will not be able to 
connect to the BGAN network, because the signal strength has not yet been accepted.

Note The display may show a different text than READY or DATA ACTIVE if there is more 
important information to show. For example, the display will show ENTER PIN? if you 
pressed C at the first request for a PIN. See also the Troubleshooting Guide on page 117.
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Using a fixed EXPLORER™ 300 (semi-fixed installation)

You can keep the EXPLORER™ 300 in a fixed position, using the Pole mount kit for 
EXPLORER™ 300. See Options and accessories on page 115 for information on type number.

Do as follows:

1. Mount the EXPLORER™ 300 on a pole or a wall, for example using the Pole mount kit.
A size M6 thread fits into the mounting bush in the back of the EXPLORER™ 300.

2. Start up the EXPLORER™ 300 and point the antenna as described in Pointing the antenna on 
page 21. 

3. Accept the signal strength by pressing OK on the EXPLORER™ 300 keypad.

4. Fasten the EXPLORER™ 300 in the pointed position. 

You only have to point the antenna once, when you mount it. Using a computer connected to the 
EXPLORER™ 300, you can set up the EXPLORER™ 300 to skip pointing at power up. Refer to 
Pointing at power up on page 85.

Note The EXPLORER™ 300 is not suited for permanent outdoor installation. 
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Making the first call

Introduction

After connecting cables, entering the PIN and pointing the antenna, you are ready to make or 
receive the first call.

The following sections provide a short guide to making calls. For more detailed information, see 
Making or receiving a phone call with the EXPLORER™ 300 on page 54.

Making a call from the EXPLORER™ 300

Your phone must be connected to the relevant interface. For further information, see 

• Standard phone: Before connecting to the Phone interface on page 51

• Bluetooth handset: Pairing devices in which you can enter a passkey on page 50.

To make a call from a phone connected to the EXPLORER™ 300, dial

00 <country code> <phone number> followed by # or off-hook key (# on analog phones, off-hook 
key on Bluetooth handsets).

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog phone, 
dial 00 45 39558800 #

Making a call to the EXPLORER™ 300

To make a call to a phone connected to the EXPLORER™ 300, dial

+870 <Mobile subscriber number>

• + is the prefix used in front of the country code for international calls. This is 00 when calling 
from most countries in Europe and from many other countries.

• Mobile subscriber number: The mobile subscriber number of the EXPLORER™ 300 you are 
calling. 
If the mobile subscriber number of the EXPLORER™ 300 is available on the SIM card, it is 
listed in the display menu system of the EXPLORER™ 300 under PROPERTIES > MOBILE 
NUMBERS. If it is not available, refer to your airtime subscription.

Example: If you are calling from Denmark to the EXPLORER™ 300 and the mobile subscriber 
number is 772112345 on your EXPLORER™ 300, dial 00 870 772112345.
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Making a call from one EXPLORER™ 300 to another EXPLORER™ 300

To make a call from one EXPLORER™ 300 to another EXPLORER™ 300, 
dial 00 870 <Mobile subscriber number>.

Receiving a call

To be able to receive a call, the phone must be connected to the correct interface of the 
EXPLORER™ 300 (Phone or Bluetooth).

To be able to receive a call with a Bluetooth handset, the handset must be paired with the 
EXPLORER™ 300. For information on how to pair Bluetooth devices, see Bluetooth pairing on 
page 50.

You can see unanswered calls in the CALLS menu of the display and the web interface.
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Making the first data connection (LAN)

Before connecting to the LAN interface

For the LAN (Local Area Network) interface to work without any further setup, the computer must 
be set up to obtain an IP address and a DNS server address automatically. 
To check these settings on your computer, do as follows (For Windows® XP):

1. From the Start menu, select Connect To > Show All Connections.

2. Double-click Local Area Connection and click Properties.

3. Select Internet Protocol (TCP/IP) from the list and click Properties. 
Make sure both fields are set to obtain an address automatically.
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Connecting to the LAN interface

Do as follows:

1. Connect the LAN cable to the network interface of your computer.
A suitable cable is provided with your EXPLORER™ 300.

2. Connect the other end of the cable to the LAN connector on the EXPLORER™ 300.

3. Start up and point the EXPLORER™ 300 as described earlier in this chapter.

4. Power on the computer.

5. When power up and pointing is completed, check the connection e.g. by starting your Internet 
Browser.
You may have to disable the Proxy server settings in your browser. For further information, 
see Browser settings on page 68.

What’s next?

After reading this chapter you should be able to start up the EXPLORER™ 300 and make a simple 
data or voice connection.

The next chapters provide more information on the user interfaces and the setup of the 
EXPLORER™ 300. The following chapter, Using the display and keypad, explains the display menu 
system, which is the basic tool for setting up the EXPLORER™ 300.
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Using the display and keypad 3

In this chapter

This chapter describes how to use the built-in display menu system of the EXPLORER™ 300. 

It contains an overview of the entire menu system followed by a description of each menu.
It also explains the symbols and messages that may appear in the display, and describes how to 
navigate using the keypad.

Menu overview

Main menu

The items of the main menu are:

• MESSAGES
shows all incoming SMS messages and allows you to open or delete each message or delete 
all messages.

• CONNECT
shows a list of the Streaming Profiles that are defined and selected for the LAN interface using 
the web interface. The CONNECT menu allows you to start and stop data sessions with the 
listed Streaming Profiles.

• CALLS
shows missed, received and outgoing calls (Voice only).

• SETTINGS allows you to

• restart the pointing procedure, 

• set display backlight and contrast, 

• set audio indications on or off, 

• enable or disable each interface, 

• enable or disable stealth mode (a terminal mode where lights and sound are off), 

• set the power up mode, and 

• restore settings.

• PROPERTIES shows:

• known and accepted Bluetooth devices, 

• GPS status,

• IP address, hardware and software numbers, 

• IMEI number, mobile subscriber numbers and voice mail numbers, and

• a list of active alarms.

• HELP DESK
shows the phone number to the Airtime Provider, if available.
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For information on how to navigate in the menu system, see Navigating the display and keypad on 
page 34.

Menu drawing

The below drawing shows an overview of the menus in the display menu system of the 
EXPLORER™ 300.

The next section shows an overview of the start-up sequence before entering the menu system. 
The menus are further described in the following sections of this chapter.

BLUETOOTH DEVICES
GPS STATUS
TERMINAL
MOBILE NUMBERS
VOICE MAIL NUMBER
ALARM LIST

<message 1>
<message 2>
<message 3>
<message 4>
DELETE ALL
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Display during start-up

Start-up sequence

There are different options for the start-up procedure. The complete startup procedure is 
described in Chapter 2, Getting started. 
This section only describes the behavior of the display during normal startup.

  
After power on you are asked for a PIN.

  
When you press OK and enter PIN, the signal 
strength screen appears.

When you have pointed the antenna and pressed OK to accept the signal strength, the display 
shows the progress in the Main screen as follows:

• SEARCHING: The EXPLORER™ 300 is searching for the network operator.

• REGISTERING: The EXPLORER™ 300 is registering itself on the BGAN network.
If the GPS position has not yet been acquired at this point, the display will show 
NO GPS. For further information, see the Troubleshooting Guide on page 117.

• READY: The EXPLORER™ 300 is registered on the network and is ready to go online.
If a computer is already connected, the display will show DATA ACTIVE instead of READY.

Main screen

The Main screen is shown after passing the PIN 
and pointing screens, and anytime you leave the 
menu system. 

The Main screen shows the most important status 
of the EXPLORER™ 300 such as battery status, 
signal strength, and general status. 

The Main screen also shows icons for any interfaces that are turned on. 
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Display symbols

Apart from the menu text, the display can show various symbols. Below is a list of the possible 
symbols with an explanation to each symbol.

Symbol Explanation

The battery charge level. 
When the level is too low (below 10%) the icon flashes. Recharge the 
battery as soon as possible.

If no battery is inserted, the symbol is not shown in the display.

The battery is charging.

The signal strength. 
Minimum two bars are normally required to be able to make a Standard 
Voice call. 

Phone interface is on.

Bluetooth interface is on.

LAN interface is on. 

Unread message (shown next to the message in the message list)

Read messages (shown next to the message in the message list)

The current connection on the BGAN network is not ciphered. Do not 
transmit data that requires ciphering.
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Navigating the display and keypad

Navigating with the keypad

The PIN must be entered before you can access the menu system.

• To access the menu system from the Main screen, press  or .

• To move up and down in the current menu, press  or .

• To select the current menu item or setting, press OK.

• To escape the current menu/setting and return to the previous level, press C.

• To see the hidden part of long text strings, press . 

• To move backwards in the menu system, or in long text strings, press .

• To adjust settings, press  and .

Short-cuts

The following short-cuts are available in the menu system:

• To exit the menu system, press and hold C for one second. The display returns to the Main 
screen.

• To activate/deactivate Stealth mode, Press C+OK.When stealth mode is activated, the display 
shows STEALTH ACTIVATED for a moment; then all lights and sounds are turned off.
 

• To turn Pointing sound on/off, Press  or  from the pointing screen. 

This action only applies to the current pointing session. To turn the sound on or off for all pointing 
sessions, select 
SETTINGS > AUDIO INDICATORS > POINTING and select ON or OFF.

Note In low temperatures the display may respond slowly when a key is pressed. At 
temperatures close to -25°C/-13°F the display may even turn black for a moment, e.g. 
when you are scrolling through a menu. After 1-2 seconds with no keypad activity the 
display will be readable again.

Note For Stealth mode to be available, it must be enabled in the EXPLORER™ 300. Refer 
to Enabling or disabling stealth mode on page 40.
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Display text

When you have not entered the menu system, the Main screen shows the currently most important 
information. Refer to Dynamic information in the display on page 45.

CANCEL in the left side of the display means: Press C to cancel the current operation. 

OK in the right side of the display means: Press OK to accept the current operation.

The menus

The following sections describe each of the menus in the menu system.

All available settings and status items are explained.

To access the menu system from the main 
screen, press  or .  
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Messages menu

Viewing the list of messages

To see the list of SMS messages, enter the menu system and select MESSAGES. 

Each message is listed with the name (if known) or the number of the sender. 
An unopened folder indicates an unread message and an opened folder indicates a read 
message.

Use  and  to scroll through the list.

For information on how new messages are presented, see Received messages on page 45.

Opening or deleting received SMS messages

To delete all messages, go to the bottom of the list of messages and select DELETE ALL.

To open or delete one message, do as follows:

1. In the MESSAGES list, select the message you want to open or delete and press OK. 

2. Then select one of the following:

• OPEN: to open the selected message.
The display shows the time and the message contents. Use  and  to scroll through the 
message and details.

• DELETE: to delete the selected message.
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Connect menu

Streaming Profiles

Using the web interface you can define a number of Profiles for data transmission. The Streaming 
Profiles defined and selected for the LAN interface appear in the CONNECT menu, and can be 
started and stopped using the keypad. 

Streaming Profiles are Profiles where the Traffic Class is set to Streaming in the Profiles window of 
the web interface.

For information on Profiles, see Using Profiles on page 106.

For information on Streaming, see Standard or Streaming data on page 60.

Starting or stopping a Streaming session

To start or stop a Streaming session on the LAN interface, do as follows:

1. Select CONNECT.

2. Select the Streaming Profile you want to start or stop.
The list only shows Profiles that have been selected for the LAN interface.
For information on how to set up the LAN interface, see Configuring the LAN interface on 
page 90.

3. Select START or STOP and confirm.

You can also start/stop Streaming sessions using the web interface. For further information, see 
Setting up and activating a Streaming connection on page 60.

Important When running a Streaming session you are charged for the time you are 
connected. An active Streaming session will stay active until you stop it.
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Calls menu

To see a list of calls or data sessions, do as follows:

1. Select CALLS. 

2. Select one of the following:

• MISSED: to see a list of incoming calls that were not answered.

• RECEIVED: to see a list of incoming calls that were answered.

• OUTGOING: to see a list of outgoing calls or data sessions.

3. Select a call from the list to see details such as time, date and phone number.
 If there was an error, the call log shows the cause of the error when possible.

When there are more than 100 calls in the list, the oldest calls are automatically deleted to make 
room for new calls. 

If you need to preserve the call log, you can export it to a file using the built-in web interface. For 
further information, see Exporting the call log on page 77.

Note Local calls are not registered.
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Settings menu

Point now

If you need to repoint the antenna, select SETTINGS > POINT NOW.

This will bring you to the Pointing screen, described in Pointing the antenna towards the satellite 
on page 23.

Setting the display backlight

To adjust the backlight of the display, do as follows:

1. Select SETTINGS > DISPLAY > BACKLIGHT. 
From this menu you can set the backlight of the display. 

2. Select one of the following:

• ON: to turn the light on.

• OFF: to turn the light off.

• TIMED: to set how long the light should be on after the last key was pressed (2, 5, 10, 30 or 
60 seconds).

• SET LEVEL: to set the level of backlight.

Setting the display contrast

To adjust the contrast of the display, do as follows:

1. Select SETTINGS > DISPLAY > CONTRAST. 
From this menu you can set the contrast of the display. 

2. Select one of the following:

• SET LEVEL: to set the contrast manually.

• AUTOMATIC: to let the EXPLORER™ 300 automatically adjust the contrast according to 
the temperature.
The contrast of the display is affected by the temperature. The EXPLORER™ 300 can 
automatically adjust the contrast so that the display looks the same, regardless of changes 
in the temperature. 

Important This function will interrupt any ongoing calls or sessions!
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Turning audio indicators on or off

The EXPLORER™ 300 has audio indicators to indicate an event. You can turn each of these audio 
indicators on or off.

1. Select SETTINGS > AUDIO INDICATOR.

2. Select one of the following:

• POINTING: a sound to indicate the signal level during pointing.

• MESSAGES: a sound to indicate that a message has arrived.

• ALARM: a sound to indicate that an alarm is present.

3. Select ON or OFF.

Enabling or disabling interfaces

Each interface can be disabled to minimize the power consumption. Specially if the 
EXPLORER™ 300 is battery powered, it is a good idea to disable unused interfaces. Do as follows:

1. Select SETTINGS > INTERFACES.

2. Select one of the following interfaces:

• PHONE
• BLUETOOTH
• LAN

3. Select ON or OFF.

Enabling or disabling stealth mode

When the EXPLORER™ 300 is in stealth mode, all lights and sounds are turned off. You can still 
use the EXPLORER™ 300, and the display text is readable.

To enable or disable the use of stealth mode, do as follows:

1. Select SETTINGS > STEALTH MODE.

2. Select one of the following:

• ENABLED
• DISABLED 

• To activate Stealth mode (after enabling Stealth mode), press C+OK on the keypad.

• To deactivate Stealth mode, press C+OK again.

Note Enabling stealth mode will not put the EXPLORER™ 300 into stealth mode, it only 
enables the use of stealth mode.
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Setting the power up mode

By default, the EXPLORER™ 300 starts up automatically when you apply external power. You can 
change this mode, so that you always have to press the Power button to switch on the 
EXPLORER™ 300.

To set the power up mode, do as follows:

1. Select SETTINGS > POWER UP MODE.

2. Select one of the following:

• AUTOMATIC: to have the EXPLORER™ 300 power up automatically when external power 
is applied.

• MANUAL: to have the EXPLORER™ 300 power up only when the Power button is pressed.

Restoring settings

You can restore default values for the settings in the SETTINGS menu, except the contrast 
setting. The following settings are restored:

• Backlight

• Audio indicators

• Stealth mode

• Interfaces enabled

• Power up mode

Note that all other settings are left unchanged.

To restore settings, do as follows:

1. Select SETTINGS > RESTORE SETTINGS. 

2. Press OK.
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Properties menu

Viewing known Bluetooth devices

You can view a list of the Bluetooth devices that are paired with the EXPLORER™ 300. The devices 
are listed with their Bluetooth names. 
The devices in this list can communicate with the EXPLORER™ 300 without any further setup.

To view the list of known Bluetooth devices, select 
PROPERTIES > BLUETOOTH DEVICES. 

To see details on a specific Bluetooth device, select the device in the list and press OK.

Viewing the GPS status

The display can show the current GPS status. 

To view the GPS status, select PROPERTIES > GPS STATUS.

The GPS status screen can vary, depending on the situation.
  

• If the GPS position has not yet been obtained, the 
display shows the status of each of the 16 GPS 
satellites as follows:

  

• If the GPS position is known, the display shows 
the GPS position, and whether it is a 2-
dimensional or 3-dimensional position (2D fix or 
3D fix).

• In some cases, the BGAN network does not allow 
the position to be displayed to the user. If this is 
the case, the display may just show GPS 
ACQUIRED. This means that the GPS position is 
received, but the user is not allowed to see it.  
This also applies if the EXPLORER™ 300 is not yet 
registered on the BGAN network, but the GPS 
position is received.
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Viewing terminal properties

You can view properties of the EXPLORER™ 300 such as IP address, hardware numbers, software 
version and IMEI number. When contacting Support, please include these numbers.

To view the properties, do as follows:

1. Select PROPERTIES > TERMINAL.

2. Select one of the following options:

• IP ADDRESS to see the IP address of the EXPLORER™ 300. This IP address is used to 
access the web interface of the EXPLORER™ 300. The web interface is a built-in web server 
used to configure and set up the EXPLORER™ 300. For further information on the web 
interface, see Using the web interface on page 67.

• HARDWARE to see the serial number, PCB numbers and MAC address of your 
EXPLORER™ 300.

• SOFTWARE to see the software version of the EXPLORER™ 300.

• IMEI to see the IMEI number (International Mobile Equipment Identity) of the 
EXPLORER™ 300. This is the unique mobile equipment number that identifies your 
EXPLORER™ 300. The IMEI number is also printed on the serial number label at the back of 
the terminal.

Viewing mobile subscriber numbers

If available on the SIM card, the MOBILE NUMBERS menu lists the mobile subscriber number to 
use when calling the EXPLORER™ 300.

To view the mobile subscriber number, select PROPERTIES > MOBILE NUMBERS.

If the mobile number is not available, the display reads 
NO INFORMATION AVAILABLE.

Viewing the voice mail number

The EXPLORER™ 300 informs you of any incoming voice mail through the display and through the 
web interface.

The voice mail number is the number you call to hear your incoming voice mail.
If available on the SIM card, the PROPERTIES menu shows the voice mail number. 

To view the voice mail number, select
PROPERTIES > VOICE MAIL NUMBER.

If the voice mail number is not available, the display reads 
NO INFORMATION AVAILABLE.
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Alarm list

If an error is present in the system, an alarm will be issued. For information on how new alarms 
are presented, see Display of alarm messages on page 122.

To view the list of currently active alarms, enter the menu system and select
PROPERTIES > ALARM LIST.

The alarms are listed with their ID numbers. 

To see the name and time stamp of the alarm, press OK. 
Use  and  to scroll through the name, ID and time stamp. If the text is too long, press OK ( ) 
to scroll through the rest of the text.

Help desk

If you need support regarding airtime, you may call the Airtime Provider help desk. 

To see the help desk number, select HELP DESK in the menu system.

The display will show the name and phone number of your Airtime Provider, if it is available on 
the SIM card. 

If the information is not available on the SIM card, you can use the built-in web interface of the 
EXPLORER™ 300 to store the help desk name and number. For further information, see Accessing 
the Help desk on page 111.
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Dynamic information in the display

Types of display information

Text in the display can be:

• Information of received messages.

• Alarms.

• Status information.

• Request for action.

Received messages

 

When messages arrive in your EXPLORER™ 300, the 
display indicates the number of new messages that have 
arrived, and the red message indicator is flashing.

The messages can be SMS messages or notification of 
voice mail. 

• If the message is an SMS message, press OK to view the message.

• If the message is information of voice mail, press OK or C to go back to the Main screen. 
The red message indicator will keep flashing until you have collected your voice mail.

• To hear your voice mail, call the voice mail service number provided by your Airtime Provider. 

• To see the voice mail service number, select 
PROPERTIES > VOICE MAIL NUMBER

Alarms

 

When alarms are issued in your EXPLORER™ 300, the 
display indicates the number of new alarms, and the red 
message indicator is flashing.

To view currently active alarms, press OK. To ignore and continue, press C.

See also:

• Display of alarm messages on page 122.

• Alarm log on page 127. 

• List of alarms on page 123.
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Status information

Status information in the display is normally shown in the lower line of the Main screen. 

Examples of status information are: READY, REGISTERING and DATA ACTIVE.

Displaying ongoing transmission

When a call or data session is in progress, the display shows DATA ACTIVE in the Main screen.

Request for action

A request for action, if it is not an alarm, is shown in the lower line of the display. This could be 
e.g. POINT NOW? or INSERT SIM.

When the text is a question, press OK to accept. 

What’s next?

This chapter has explained how to navigate in the display menu system and how to use it for basic 
setup of the EXPLORER™ 300.

The following chapter, Using the interfaces, explains in detail how to set up and use each interface 
of the EXPLORER™ 300.

WARNING! When the EXPLORER™ 300 is powered on, stay clear of the antenna 
front! The antenna emits radio frequency energy, not only when the display shows 
DATA ACTIVE. Always keep a minimum distance of 0.6 m from the antenna front.
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In this chapter

This chapter describes how to use the interfaces of the EXPLORER™ 300. For each connection type 
it describes how to connect cables and the necessary setup to establish a connection. 

It does not describe advanced configuration of interfaces. For this type of information, refer to the 
“Configuring...” sections for the data interfaces in Chapter 5, Using the web interface.

General

Tools for setup and use

Overview

The display and keypad can be used for simple setup, but for enhanced use and for configuration 
of interfaces, you need to connect a computer (PC, laptop or similar).

With a computer and a browser, you can use the following to set up the EXPLORER™ 300:

• The built-in web interface of the EXPLORER™ 300

• The BGAN LaunchPad

The web interface of the EXPLORER™ 300

The web interface is a built-in web server for setting up and controlling the EXPLORER™ 300, 
using a connected computer with a browser. For information on how to use the web interface, see 
Using the web interface on page 67.

The BGAN LaunchPad

BGAN LaunchPad from Inmarsat is a computer application for setting up terminals in the BGAN 
system. A CD-ROM with the LaunchPad is included in the delivery. For information on how to use 
the LaunchPad, refer to the user guide provided with the LaunchPad.
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Services and interfaces

A variety of services can be accessed from different interfaces on the EXPLORER™ 300. 

The following table shows the possible combinations of services and interfaces, and which types of 
equipment can be used.

Service

Interface on the EXPLORER™ 300

Phone Bluetooth LAN
Display/
Keypad
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Standard 
Voice

Analog 
telephone

Bluetooth 
handset
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Data
single-user

Computer Computer

SMS Computer Computer View only
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Enabling or disabling an interface

Overview

By default, all interfaces are enabled. However, you can disable the LAN interface, the Bluetooth 
interface and/or the Phone interface in order to minimize the power consumption.

Using display and keypad

To enable or disable an interface using the display and keypad, do as follows:

1. Enter the menu system.
From the Main screen, press  or .

2. Select SETTINGS > INTERFACES.

3. Select the interface you want to enable or disable.

4. Select ON to enable or OFF to disable.

Using web interface

To enable or disable an interface using the web interface, do as follows:

1. Connect a computer. Refer to the relevant section in this chapter, e.g. Connecting to the LAN 
interface on page 62.

2. Access the web interface.
For further information, see The web interface on page 67.

3. From the left navigation pane in the web interface, select
SETTINGS > Interfaces.

4. Select Enabled or Disabled next to the relevant interface.
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Bluetooth pairing

What is pairing?

Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate with one 
another. When this happens, the two devices exchange passkeys and join a pair. The pairing 
process only takes place the first time the two devices are connected. Once the two devices have 
established a pair, they automatically accept communication when one device recognizes the 
other device.

Pairing devices in which you can enter a passkey

This section describes how to pair devices in which you can enter a passkey. 

For information on pairing devices with a fixed passkey from your EXPLORER™ 300, see Pairing 
Bluetooth devices from the web interface on page 95.

The following procedure presupposes that the EXPLORER™ 300 is configured to be visible to other 
Bluetooth devices, and that the Bluetooth interface is turned on. For information on configuration, 
see Configuring the Bluetooth interface on page 93.

Do as follows to pair the devices:

1. Start up the EXPLORER™ 300.
For further information, see Getting started on page 11.

2. Turn on Bluetooth on your Bluetooth device and place it close to the EXPLORER™ 300.

3. On your Bluetooth device, search for new devices and select the EXPLORER™ 300 when it is 
found. 
The default Bluetooth name of the EXPLORER™ 300 is EXPLORER 300.
If there is more than one EXPLORER™ 300 in the list, you can use the MAC address to locate 
the correct one. To see the MAC address of your EXPLORER™ 300, enter the display menu 
system and select PROPERTIES > TERMINAL > HARDWARE > MAC.

4. On your Bluetooth device, enter the passkey of your EXPLORER™ 300. 
The default passkey is the serial number of your EXPLORER™ 300. To see the serial number, 
look at the label on the back of your EXPLORER™ 300, or enter the menu system and select 
PROPERTIES > TERMINAL > HARDWARE > UNIT SER. NO.

The new device is now paired and ready to communicate with the EXPLORER™ 300.

Note The method for pairing devices may vary depending on your Bluetooth device. Consult 
your Bluetooth device documentation for information.

Note Maximum 2 devices can be paired with the EXPLORER™ 300. If you have already paired 
2 devices you have to unpair a device before you can pair a new one. For information on 
how to unpair devices, see Unpairing devices on page 97.
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Using a phone

Connecting an analog phone

Before connecting to the Phone interface

To connect a phone to the Phone connector, you need an analog telephone cable with an RJ-11 
connector. For specifications and pin-out, refer to Phone interface on page 131.

Connecting to the Phone interface

Do as follows:

1. Connect the cable to your phone.

2. Connect the other end of the cable to the Phone 
connector on the EXPLORER™ 300.   

3. Power up the EXPLORER™ 300 and point the antenna as described in Pointing the antenna on 
page 21. 

4. Check the connection by making a phone call. 
See Making or receiving a phone call with the EXPLORER™ 300 on page 54.

If connection fails, check that the interface is enabled in the EXPLORER™ 300.
If the analog phone icon is not present in the display Main screen and in the Home window of the 
web interface, the interface is disabled. 
See Enabling or disabling an interface on page 49.

If the interface is enabled, but connection fails, refer to the Troubleshooting Guide on page 119.
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Connecting a Bluetooth handset

Before connecting a Bluetooth handset

To use a Bluetooth handset with the EXPLORER™ 300, you first have to pair the two devices.
For information on pairing devices, see Bluetooth pairing on page 50.

The Bluetooth handset must be placed within a maximum distance of 25 m from the 
EXPLORER™ 300. Note that this is the maximum distance in open air; the actual maximum 
distance may be shorter, depending on the environment. In an office environment, you should be 
able to establish a connection to the adjoining room.

Connecting a paired Bluetooth handset

This section does not describe configuration of the Bluetooth interface. For information on 
configuration, see Configuring the Bluetooth interface on page 93.

If the devices are already paired, do as follows to connect:

1. Power up the handset and the EXPLORER™ 300. 

2. Place the handset close to the EXPLORER™ 300. 

3. Turn on Bluetooth on your device.
The Bluetooth connection should now be established, and you are ready to make a call.

If connection fails, check that the interface is enabled in the EXPLORER™ 300.
If the Bluetooth icon is not present in the display Main screen and in the Home window of the web 
interface, the interface is disabled. 
See Enabling or disabling an interface on page 49.

If the interface is enabled, but connection fails, refer to the Troubleshooting Guide on page 120.

For information on how to make and receive calls, see Making or receiving a phone call with the 
EXPLORER™ 300 on page 54.

Note Maximum 2 devices, 1 voice and 1 data device, can be connected at the same time.
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Entering the SIM PIN using a phone

Entering the PIN

If you have a phone connected to the EXPLORER™ 300, you can use it to enter the PIN at start up, 
as an alternative to the keypad.

When the EXPLORER™ 300 is waiting for a PIN, you will hear 2 beeps - pause - 2 beeps - etc. in 
your phone.

You simply dial the PIN the same way you would dial a phone number:

• For an analog phone, take the phone off hook and dial <PIN> followed by #. When you hear a 
“busy” tone or a dialing tone, the PIN has been accepted and you can put the phone back on 
hook.

• For a Bluetooth handset, dial <PIN> and press off hook key. When you hear a “busy” tone or a 
dialing tone, the PIN has been accepted and you can press the on hook key or dial a number.

Wrong PIN

If, instead of the busy tone or dialing tone, you continue to hear 2 beeps - pause - 2 beeps - etc., it 
means the PIN was wrong. Check that you have the correct PIN and try again.

If a wrong PIN has been entered three times, you will hear 3 beeps - pause - 3 beeps - etc. This 
means you have to enter the PUK (PIN Unblocking Key) provided with your SIM card. 
After entering the PUK, you must enter a new PIN of your own choice (4 to 8 digits long).

Dial the following:

<PUK> * <New PIN> * <New PIN> followed by # or off-hook key.

Example: If the PUK is 87654321 and the new PIN is 1234, dial

87654321 * 1234 * 1234 followed by # or off-hook key.

If you enter 10 wrong PUKs, the SIM card will no longer be functional. Contact your Airtime 
Provider for a new SIM card.
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Making or receiving a phone call with the EXPLORER™ 300

Analog phone or Bluetooth handset

First connect your phone to the relevant interface. For further information, see Before connecting 
to the Phone interface on page 51, or, for the Bluetooth handset, Pairing devices in which you can 
enter a passkey on page 50.

Making a call

You have two methods for making a call:

• Short Dial. If the number is in the phone book of the EXPLORER™ 300, you can use the Short 
Dial number, which is found in the first column of the phone book in the web interface. See 
Short dial on page 76.
Simply dial 0 <Short Dial> followed by # or off-hook key.

Example: To call entry number 4 in the phone book, 
dial 04 followed by # or off-hook key.

• Manual Dial. To make a call, dial
00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog phone, dial 
00 45 39558800 #

If there was an error establishing the connection, the web interface and the display of the 
EXPLORER™ 300 show an error message. Refer to the Troubleshooting Guide on page 119.

Receiving a call

To be able to receive a call, the phone must be connected to the relevant interface on the 
EXPLORER™ 300. 

By default, all devices connected to the Phone interface or the Bluetooth interface will ring when 
one of the mobile subscriber numbers is called. 

Information of missed calls is stored in the call log of the EXPLORER™ 300. You can view the call 
log with the display menu system or the web interface. See Calls menu on page 38 or Viewing the 
lists of calls on page 78.

Note There are different methods for activating a call, depending on the type of phone:

• Analog phone: Dial # after the number.

• Bluetooth handset: Press the off-hook key after the number.
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Making a call to the EXPLORER™ 300

To make a call to a phone connected to the EXPLORER™ 300, dial 

+870 <Mobile subscriber number>

• + is the prefix used in front of the country code for international calls. This is 00 when calling 
from countries in Europe and from many other countries.

• Mobile subscriber number. If the mobile subscriber numbers are available on the SIM card, 
you can look them up using the display menu system or the web interface. 

• Display menu system: 
Enter the menu system and select PROPERTIES > MOBILE NUMBERS.

• web interface:
If a computer is connected, access the web interface, select PROPERTIES and locate the 
Mobile subscriber numbers section. For further information on the web interface, see The 
web interface on page 67.

If the mobile subscriber numbers are not available in the display menu system nor the web 
interface, refer to your airtime subscription.
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Dialing functions

Overview

There are a number of dialing functions available in the EXPLORER™ 300.

The following list shows the allocated special-purpose numbers for the EXPLORER™ 300.

Apart from the numbers above, the EXPLORER™ 300 uses the following dialing prefixes:

• #31# before the phone number will hide the callers phone number to the recipient.

• *31# before the phone number will show the callers phone number to the recipient where it 
would otherwise be hidden, e.g. because the number is an ex-directory number.

• R is used during a call to indicate that the following key-presses should activate a 
supplementary services function. The supplementary services functions supported by the 
EXPLORER™ 300 are described in the subsequent sections.

Number Function

0 * followed by # or off-hook key Redial last called number on this interface.

00 * followed by # or off-hook key Redial last answered call on this interface.

Note: If the last answered number is an unlisted 
number, you will not be allowed to dial back.

0 followed by one of the numbers 1-199
and # or off-hook key

Short dial phone numbers in phone book.

0201 or 0202 followed by # or off-hook key Local call to Bluetooth handset.

0301 followed by # or off-hook key Local call to analog phone. 
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Making local phone calls

You can make local calls between an analog phone and a Bluetooth handset connected to the 
EXPLORER™ 300.

Local phone numbers always start with 0.

For an overview of the numbers, see Overview on page 56.

To make a local call, dial
<local number> followed by # or off-hook key.

You can look up the local Bluetooth phone numbers in the display or in the web interface as 
follows:

• Display 
Enter the menu system and select PROPERTIES > BLUETOOTH DEVICES. The list 
shows accepted Bluetooth devices with local number and Bluetooth name.

• web interface 
Access the web interface and select
SETTINGS > Interfaces > Bluetooth > Paired Devices. 
The paired voice devices are listed with their local phone numbers.

Handling waiting calls

During a call, if a second party attempts to make contact with you, you will hear a Call Waiting 
indication. The Call Waiting indication is two beeps and a pause of 3 seconds, then two beeps 
again etc. If no action is taken, the waiting call is released after a time out period.

When you receive a Call Waiting indication, you have the following options:

Note You can only have one Bluetooth handset connected at a time.

Note The phone must have an R key to be able to use these functions.

The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.

If you want to: Do as follows:

Clear the current call,
and accept the waiting call.

Press R 1 #, within the time out period.

Hold the current call,
and accept the waiting call.

Press R 2 #, within the time out period.

Ignore the waiting call. Take no action.

Reject the waiting call. Press R 0 #, within the time out period.
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Holding a call

During a call, you may place the initial call on hold while another call is made. 

Transferring a call

When you receive a call, you can transfer this call to another phone or headset connected to the 
EXPLORER™ 300.

To transfer the incoming call to another phone or headset, do as follows:

1. Press R 4 * <local number> #.
The phone or headset with the local number you dialed starts to ring. 
If your phone and the recipient’s phone or headset are both Bluetooth devices, your phone is 
now disconnected. When the call is answered, a connection is established between the initial 
caller and the new recipient.

2. If only one or none of the devices are Bluetooth devices, you have two options.

• Hang up. The phone or headset you transferred the call to continues to ring. When the call 
is answered, a connection is established between the initial caller and the new recipient.

• Do not hang up. When the new recipient answers, you can have a conversation before 
hanging up. When you hang up, the call is handed over to the initial caller.

Note The phone must have an R key to be able to use these functions.

The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.

If you want to: Do as follows:

Place a call on hold. Press R 2 #.

Place the existing call on hold and establish a 
new call.

Press R and dial the second phone number 
followed by #.

Shuttle between the two calls. Press R 2 #
(irrespective of whether the second call was 
acquired using Call Hold or acceptance of Call 
Waiting.)

Clear the held call, if no waiting call exists. Press R 0 #.

Clear an active call and return to the held call. Press R 1 #. 
Note that this is only possible if no waiting 
call exists.

Note The phone must have an R key to be able to use these functions.

The EXPLORER™ Bluetooth Handset uses a softkey in stead of the R key.
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 Using a computer

Choosing an interface for data connection

The EXPLORER™ 300 has two types of interface for data connection: LAN and Bluetooth. 

The following table shows some characteristics of each interface, to help you choose the right 
interface for your application.

Interface
Power 

Consumption
Amount of Setup Range

LAN High None 
(or very little)

Up to 100 m of cable

Bluetooth Medium Can be complicated, 
depending on 
operating system.

Wireless connection.

Up to 25 m depending on the 
transmitter in the computer and on 
the transmission conditions.
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Standard or Streaming data

Definition

The BGAN network supports different classes of data connection to the Internet. The main classes 
are Standard data and Streaming data.

• Using a Standard data connection, several users can share the data connection 
simultaneously. This type of connection is ideal for TCP/IP traffic such as e-mail, file transfer, 
and Internet and intranet access. 
The user pays for the amount of data sent and received.

• Using a Streaming data connection, you get an exclusive, high-priority connection, ensuring 
seamless transfer of data. This type of connection is ideal for time critical applications like live 
video over IP.
The user pays for the duration of the connection (per minute charge).

You can set up various types of connection using the Profiles and a Traffic Flow Template. For 
further information, see Using Profiles on page 106 and Using a Traffic Flow Template on page 109.

Setting up and activating a Streaming connection

By default, any data connection on the EXPLORER™ 300 is a Standard data connection.

If you want to set up a Streaming connection, select a Streaming Profile when setting up your data 
interface. See the “Configuring...” section for your interface in Chapter 5, Using the web interface. 

Before starting a Streaming session on the LAN interface, make sure you have set up the 
Streaming Profile for the LAN interface.

To start or stop a Streaming session on the LAN interface, do as follows:

1. Access the web interface.

2. Go to the Home window and locate the field STREAMING PROFILES ON LAN.

3.  Click the Start or Stop link of the relevant Streaming Profile. 

Note For optimum performance it is important that you select the right traffic class when 
defining Profiles for your connection. 

Note When running a Streaming session you are charged for the time you are connected. 
A started Streaming session will stay active until you stop it.
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Using the LAN interface

Before connecting to the LAN interface

To connect to the LAN (Local Area Network) interface, use a shielded cable mounted with an RJ-45 
connector. 
The LAN interface is configured as MDI-X. This means that you should use a straight cable.

For specifications, refer to LAN interface on page 132.

For the LAN interface to work without any further setup, the computer must be set up to obtain an 
IP address and a DNS server address automatically. 

To check these settings on your computer, do as follows (For Windows XP):

1. Select Connect To > Show All Connections from the Start menu.

2. Double-click Local Area Connection.

3. Click Properties

4. Select Internet Protocol (TCP/IP) from the list and click Properties. 
Make sure both fields are set to obtain an address automatically.
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Connecting to the LAN interface

This section does not describe configuration of the LAN interface. For information on 
configuration, see Configuring the LAN interface on page 90.

To connect to the LAN interface, do as follows:

1. Connect the LAN cable to the network interface of your computer.
A suitable cable is provided with your EXPLORER™ 300.

2. Connect the other end of the cable to the LAN 
connector on the EXPLORER™ 300. 

3. Power up the EXPLORER™ 300 and point the antenna as described in Pointing the antenna on 
page 21. 
After pointing, the connection is automatically established. By default, the connection is a 
Standard data connection.

4. Check the connection, e.g. by starting your Internet Browser.

If connection fails, check that the interface is enabled in the EXPLORER™ 300. If the LAN icon is 
not present in the display Main screen and in the Home window of the web interface, the interface 
is disabled. See Enabling or disabling an interface on page 49.
If connection still fails, refer to the Troubleshooting Guide on page 120.
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Using a computer with Bluetooth

Before connecting a computer to the Bluetooth interface

The EXPLORER™ 300 supports various Bluetooth profiles. Remember to activate/install the 
profile(s) you are going to use on your computer.

For a list of supported Bluetooth profiles, see Bluetooth interface on page 133.

The computer should be placed within a maximum distance of 25 m from the EXPLORER™ 300. 
Note that this is the maximum distance in open air; the actual maximum distance may be shorter, 
depending on the environment. In an office environment, you should be able to establish a 
connection to the adjoining room.

If the two devices have not been connected before, you need to pair the devices. For further 
information, see the section Bluetooth pairing on page 50.

Connecting a computer to the Bluetooth interface

This section does not describe configuration of the Bluetooth interface. For information on 
configuration, see Configuring the Bluetooth interface on page 93.

If the devices are already paired, do as follows to connect:

1. Place the computer close to the EXPLORER™ 300.

2. Power up the EXPLORER™ 300 and point the antenna.

3. Power up your computer.

4. Turn on Bluetooth on your computer.
If the devices are paired, the Bluetooth connection should now be established.
Note that if your Bluetooth connection is defined as a dial-up connection, you have to open 
the dial-up connection before you can access the Internet or the web interface. See Creating a 
dial-up connection on page 64.

 

If connection fails, check that the interface is enabled in the EXPLORER™ 300.
If the Bluetooth icon is not present in the display Main screen and in the Home window of the web 
interface, the interface is disabled. See Enabling or disabling an interface on page 49. If the 
interface is enabled but connection fails, refer to the Troubleshooting Guide on page 121.

Note The procedure may vary depending on the Bluetooth interface in your computer. Consult 
your Bluetooth manual for details.

Note Max. 2 devices, 1 voice and 1 data device, can be connected simultaneously.
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Creating a dial-up connection

Do as follows: 

1. Start up your computer and the EXPLORER™ 300.

2. Place your paired Bluetooth computer close to the EXPLORER™ 300. For information on 
Bluetooth, see Using a computer with Bluetooth on page 63.

3. On your computer, select Connect To from the Start menu.

4. Select Show All Connections.

5. Open the New Connection Wizard and click Next.

6. Select Connect to the Internet and click Next.

7. Select Set up my connection manually and click Next.

8. Select Connect using a dial-up modem and click Next.
If other modems are installed, you must select the Bluetooth driver from a list of modems.

9. In the ISP Name field, type a name for your connection and click Next.

10. When you are asked for a phone number, type: 
*98# if you want a Standard data connection to the Internet and/or the web interface, or *99# 
if you are going to connect only to the web interface of the EXPLORER™ 300.

Note The following description is for Windows XP. If you are using a different operating 
system, the procedure may be different.
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To dial up using a specific Profile, type *98*<CID>#. 
To find the <CID> number, access the web interface, select SETTINGS > Interfaces > Bluetooth 
and locate the Profile CIDs section at the bottom of the window. 
For further information, see Configuring the Bluetooth interface on page 93. 

11. Click Next twice.

12. Click Finish.

When you connect to the Bluetooth interface using dial-up, you must open this dial-up connection 
to access the Internet or the web interface.

To open the dial-up connection (in Windows XP), select Connect To from the Start menu, select 
your dial-up connection and click Dial. When the connection is established, you can access the 
Internet as usual.
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Additional interfaces

Using the EXPLORER™ Bluetooth Handset charger

Before connecting to the EXPLORER™ Bluetooth Handset charger interface

If you are using an EXPLORER™ Bluetooth Handset, you can recharge the handset using the DC 
charger interface of the EXPLORER™ 300.

Use the charger cable supplied with the EXPLORER™ Bluetooth Handset.

For specifications on the charger interface, see EXPLORER™ Bluetooth Handset charger interface 
on page 135.

Connecting to the EXPLORER™ Bluetooth Handset charger interface

Do as follows:

1. Connect the EXPLORER™ 300 to power, either using the AC/DC adapter connected to a 100-
240 V AC electrical outlet, or the Car charger cable connected to the cigarette lighter 
socket/12 V DC in a car.

2. Connect the Bluetooth charger cable to the charging 
connector on the EXPLORER™ 300.   
The charging connector is located at the back of the 
EXPLORER™ 300, and is marked DC OUT. Make sure 
the connector is oriented correctly in relation to the 
coding of the plastic insert.

3. Connect the other end of the cable to your EXPLORER™ Bluetooth Handset.
If the EXPLORER™ 300 is connected to power, the battery of the Bluetooth Handset is now 
recharged.

What’s next?

This chapter has described the basics of how to set up and use each interface.

The following chapter, Using the web interface, describes how to use the built-in web interface for 
setting up and using the EXPLORER™ 300.

Note The Bluetooth handset charger cannot recharge the Bluetooth handset from the 
EXPLORER™ 300 battery. The EXPLORER™ 300 must be connected to external 
power.

Illustration showing 
DC OUT connector
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In this chapter

This chapter describes how to use the web interface to operate, set up and configure the 
EXPLORER™ 300. 

Initial configuration of interfaces is described in the chapter Using the interfaces on page 47.

Introduction

The web interface

What is the web interface?

The web interface is a built-in web server in the EXPLORER™ 300, used for operating, setting up 
and configuring the EXPLORER™ 300. 

You can access the web interface from a standard Internet browser. 

Internet Explorer 6.0, Mozilla Firefox 1.0 and Apple Safari 2.0 have been tested successfully with 
the web interface.

You may be able to use other browser versions as well.

Connecting

Connect your computer to the EXPLORER™ 300.

Make sure your computer is set up for the interface you are planning to use for connecting to the 
EXPLORER™ 300. You can use LAN or Bluetooth. See Using the interfaces on page 47 for details.

To access the web interface, an Internet browser must be installed on the computer. 

Important If you are going to use Bluetooth with Dial-up Networking to access only the web 
interface and not the Internet, you must use a dial-up connection with the phone 
number set to *99#. For further information, see Creating a dial-up connection on 
page 64.
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Browser settings

If you are connecting your computer using the LAN interface, the Proxy server settings in your 
browser must be disabled before accessing the web interface. 

Most browsers support disabling of the Proxy server settings for one specific IP address, so you 
can disable Proxy server settings for the web interface only, if you wish. Consult your browser help 
for information.

To disable the use of a Proxy server completely, do as follows:

1. In Microsoft Internet Explorer, select Tools > Internet Options > Connections > LAN Settings.

2. Uncheck the box labeled Use a proxy server for your LAN. 

3. Click OK.

When the proxy server settings are disabled, close your browser. 

You may need to change this setting back on return to your Internet connection.

Note The following description is for Microsoft Internet Explorer. If you are using a different 
browser, the procedure may be different.
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Accessing and navigating the web interface

Accessing the web interface

To access the web interface from a connected computer, do as follows:

1. Connect your computer to the EXPLORER™ 300.
For further information, see Using a computer on page 59.

2. Start up the EXPLORER™ 300. 
For further information, see Getting started on page 11.

3. Open your browser and enter the IP address of the EXPLORER™ 300.
The standard IP address is 192.168.0.1.
If your EXPLORER™ 300 uses a different IP address, you can look it up by entering the display 
menu system of the EXPLORER™ 300 and selecting 
PROPERTIES > IP ADDRESS.

Overview of the web interface

The web interface consists of the following sections. 

Navigation

Status

Icon Bar Contents Section

Pane

Menu Path

Field
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• The navigation pane holds the main menu. Clicking an item in the menu opens a submenu in 
the navigation pane or a new page in the contents section.

• The status field shows battery status and signal strength.

• The icon bar shows an icon for each interface that is enabled. It also shows icons for new SMS 
messages and for active alarms, when relevant. For explanations of the icons, see the next 
section, Icons in the icon bar.

• The menu path shows the path through the menu system to the current page shown in the 
contents section. 

• The contents section shows the page selected in the navigation pane. This section is used for 
viewing or changing settings, or for performing actions.

Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Navigating the web interface

• To expand a menu, click the menu in the navigation pane. 

• To access status and settings, click the relevant subject in the navigation pane, or an icon in 
the icon bar. The status or settings are displayed in the contents section.

• To see the site map, click SITE MAP in the navigation pane. Click on items in the site map to 
go directly to the relevant location.

• To return to the Home window from anywhere in the system, click Home, either from the 
navigation pane or from the menu path below the icon bar.

Icon Explanation

Phone interface is on.

Bluetooth interface is on.

LAN interface is on. 

A new SMS message, or information of Voice mail, has arrived.

Click the icon to see new messages or information of Voice mail. For 
further information, see Receiving a message on page 81.

An alarm is pending.

Click the icon to see a list of active alarms. For explanations of the alarm 
messages, see List of alarms on page 123.

Note that the alarm icon will remain in the icon bar as long as the cause 
of the alarm is still present.
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Entering the SIM PIN in the web interface

If a computer is connected when you start up the EXPLORER™ 300, and the web interface is 
accessed, you can enter the SIM PIN from the web interface.

Until you enter the PIN in the Home window, you can only access the PROPERTIES window and 
upload software. Access to all other parts of the web interface requires a PIN.

Type in the PIN and press OK.

If you enter a wrong PIN 3 times you are asked for a PUK (PIN Unblocking Key). For further 
information, see Wrong PIN on page 20.

If the PIN has already been accepted in the EXPLORER™ 300, or the PIN is disabled e.g. from the 
BGAN LaunchPad, the web interface goes directly to the Home window at start-up. 

When the PIN is accepted, the web interface opens the Home window and is ready for use.
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The Home window

Overview

The Home window of the web interface contains a “dashboard” for control and inspection of 
ongoing communication and for viewing properties of the EXPLORER™ 300.

The NETWORK section shows the name of the Airtime Provider, if this information is available on 
the SIM card.

Terminal properties

The TERMINAL section of the Home window shows the following:

• Status. The status of the EXPLORER™ 300. This field corresponds largely, but not completely, 
to the status information in the display. 
Examples of status information are: Ready, Registering and Data active.

• Pointing. If you want to point the antenna, click the link Go to pointing mode. For further 
information, see Pointing using web interface on page 74.

• Unit serial number. The serial number of the total unit.

• Software version. The version of the software embedded in the EXPLORER™ 300.

• Local IP address. The local IP address of the EXPLORER™ 300. 
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• IMEI number. The IMEI number (International Mobile Equipment Identity) of the 
EXPLORER™ 300. This is a unique number that identifies your EXPLORER™ 300. The IMEI 
number is also printed on the serial number label at the back of the terminal.

• MAC address of the EXPLORER™ 300.

Managing calls and data sessions

Start/stop a Streaming session on the LAN interface

To start or stop a Streaming session, click the relevant link under STREAMING PROFILES ON LAN.
For information on setup of the LAN interface, see Configuring the LAN interface on page 90. 
For information on how to set up a Profile, see Using Profiles on page 106.

Viewing information on calls and data sessions

The following sections in the Home window show information on calls and data sessions.

• ONGOING CALLS is a list of calls that are currently active. The list shows the Voice quality and 
the time connected for each call.

• ONGOING DATA SESSIONS is a list of data Profiles that are currently active, including the IP 
address that is assigned to each PDP context.

• SESSIONS TOTAL lists the totals for each connection. The list shows the time connected for 
voice and Streaming data, and MB transferred for Standard data.

Note Before starting a Streaming session, make sure you have set up a Streaming Profile and 
activated it in the SETTINGS > Interfaces > LAN window.
TT 98-123571-DraftA The Home window 73



Chapter 5: Using the web interface
Pointing using web interface

Instead of using the display for observing the signal strength you can view and accept the signal 
strength in the web interface.

Do as follows:

1. From the TERMINAL section of the Home window in the web interface, click the link Go to 
pointing mode. The Pointing window opens, and the EXPLORER™ 300 enters pointing mode.

2. Point the antenna as described in Pointing the antenna on page 21, while observing the signal 
strength in the web interface.

3. When you have obtained the highest signal strength you can get, click Accept.

The web interface now returns to the Home window, and the EXPLORER™ 300 tries to establish a 
connection and register on the BGAN network. 

Note At this point the EXPLORER™ 300 may make a sound. This sound is used for 
pointing the antenna. The frequency of the sound increases with the signal strength.

To toggle the pointing sound on/off, press  or on the keypad of the 
EXPLORER™ 300.
TT 98-123571-DraftA The Home window 74



Chapter 5: Using the web interface
Using the phone book

General usage

Overview

In the phone book you can:

• Look up phone numbers.

• Look up short dial numbers for easy dialing from an analog or Bluetooth handset. 

• Modify or delete existing names and phone numbers, or enter new names and phone 
numbers.

Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane. 

The phone book shows all entries with entry number, name and phone number. Empty place 
holders are also included. 
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To sort the phone book, click the title of the column you wish to sort by. For example, to sort by the 
names in the phone book alphabetically, click on Name in the top row of the phone book.

The phone book is divided into subpages. To select the subpages you want, click the relevant link 
at the bottom of the page.

Short dial

The entry number in the phone book is the Short dial number. When making a call from the 
EXPLORER™ 300 you can use this number instead of dialing the entire phone number.

Simply dial 0 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone, take the phone off hook 
and dial 03 #.

Editing phone book entries

Adding a new entry

To add a new entry, do as follows:

1. In the phone book, locate the empty entry number where you want to add the new phone 
number and click New.

2. Type in the name and phone number of the new entry and click Save entry.
The new name and number are now listed at the specified entry number in the phone book.

Modifying an entry in the phone book

To modify an entry, do as follows:

1. In the phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.
The name and/or number in the selected entry is now replaced with the new information.

Deleting an entry in the phone book

To delete an entry, click Delete next to the entry you want to delete.

Deleting all entries in the phone book

To delete all the entries in the phone book, click Delete all entries in phone book at the bottom of 
the PHONE BOOK window.
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Call log

Information on total usage

To enter the CALLS window select CALLS from the left navigation pane. The CALLS window 
contains information on time connected for circuit switched connections.

Exporting the call log

The EXPLORER™ 300 logs all calls and data sessions. For information on how to view the lists of 
calls and data sessions, see the next section. 

To export the entire call log to a file, do as follows:

1. In the CALLS window, click the link Export total Call Log to file.

2. Browse to the location where you want to save the log.

3. Click OK.
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Viewing the lists of calls

To see information on outgoing, received or missed calls or data sessions, select one of the 
following lists from the left navigation pane in the CALLS window:

• Outgoing calls shows the start time, receiving end phone number, duration, type and 
estimated charge of each outgoing call. 

• Received calls shows the start time, calling phone number, duration and type of each 
incoming call.

• Missed calls shows the start time, calling phone number and type of each incoming call that 
was not received.

• Standard data sessions shows the start time, bytes in, bytes out and estimated charge of each 
Standard data session.

• Streaming data sessions shows the start time, duration, type (Streaming 32, 64 kbps) and 
estimated charge of each Streaming data session.

Date and time is UTC time, received from the satellite. 

You can sort each of the lists by clicking the title of the column you wish to sort by. 

If a list covers more than one page, you can click the relevant link at the bottom of the page, to go 
to another page.

When there are more than 100 calls in the total list, the oldest calls are automatically removed to 
make room for new calls.

Note The estimated charge is based on your entries under ADMINISTRATION > Call charges. 
Thrane & Thrane does not take responsibility for the correctness of this estimated 
charge.
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Handling messages

Sending an SMS message from the EXPLORER™ 300

To send an SMS message from the EXPLORER™ 300, do as follows:

1. Click MESSAGES from the left navigation pane.
This window contains new incoming messages.

2. In the left navigation pane, click Write message.

3. Type in the message in the WRITE NEW MESSAGE field.
If the message text is too long for one SMS, the message is sent as two or more SMS 
messages. The field below the message field shows the number of SMS messages used to 
send the message.

4. Type in the phone number in the Recipient field. 
Remember 00 and country code
(e.g. 00 45 to call Denmark or 00 1 to call USA).

5. Select whether or not you want Delivery notification for this SMS message. 

Important If the EXPLORER™ 300 is not online when you attempt to send a message, the 
message is moved to the Outbox in stead of the Sent folder. Messages in the Outbox 
are not automatically sent when the EXPLORER™ 300 goes online. For further 
information on the Outbox, see the next section, Options for messages in the Outbox.

To make sure a message has been sent, check that it is in the Sent folder.
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If you click Yes, the Status column in the Sent folder will show the status of your message 
when it has been sent.
You can set up delivery notification generally for all SMS messages. This setting is used by 
default when you send a message. For further information, see Configuring message settings 
on page 83.

6. Click Send.
If the EXPLORER™ 300 is online, the message is now sent and moved to the Sent folder. 

Options for messages in the Outbox

Messages in the Outbox are messages that have not been sent, e.g. because the EXPLORER™ 300 
was not online when you attempted to send the messages.

To access the Outbox, click MESSAGES > Outbox from the navigation pane.

You have the following options for messages in the Outbox:

• When the EXPLORER™ 300 is online, click Resend next to the message you want to send. 
When the Write message window opens, click Send.
The EXPLORER™ 300 now attempts to send the message again. To make sure the message 
has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all messages in Outbox to delete all the messages.

Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.

To access the Sent folder, select MESSAGES > Sent from the navigation pane. 

The Status column shows the status of each message, if you have selected Delivery notification 
when sending the message.

From the Sent folder you have the following options:

• Click Resend next to a message you want to send again. 
When the Write message window opens, click Send.
The EXPLORER™ 300 now attempts to send the message again. To make sure the message 
has been sent, look in the Sent folder. There should now be two copies of the sent message.

• Click Forward next to a message you want to forward. 
When the Write message window opens, type in the phone number of the new recipient and 
click Send.
The EXPLORER™ 300 now attempts to send the message to the new recipient. To make sure 
the message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all sent messages to delete all the messages.

Note The original message remains in the Outbox. When you have succeeded in sending 
the message you may want to delete it from the Outbox.
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Sending an SMS message to the EXPLORER™ 300

You can send an SMS message to the EXPLORER™ 300 e.g. from a mobile phone, using one of the 
mobile subscriber numbers for voice. Dial

+870 <Mobile subscriber number>

To see the voice numbers of your EXPLORER™ 300, select PROPERTIES from the web interface or 
from the display menu system and view Mobile subscriber numbers. Note, however, that these 
numbers are only listed if they are available on the SIM card. Otherwise, refer to the information 
included with your airtime subscription.

Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an unopened 
envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages, click MESSAGES from the left navigation pane. 

The window shows new incoming messages. 

If the message is not an SMS message but information of voice mail, call your voice mail service 
number to hear the voice mail.
To find your voice mail service number, select MESSAGES > Message settings from the left 
navigation pane and locate the Voice mail service number. 

Note that the voice mail number is only shown if it is available on the SIM card. Otherwise, refer to 
the information included with your Airtime subscription.

Note The EXPLORER™ 300 does not accept more than 100 incoming messages (including read 
and unread messages). If you have received 100 messages, you have to delete some of 
them in order to free space for new messages. Otherwise, the new messages are 
rejected.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane. 

Besides viewing the new messages, you have a number of options for what to do with each 
message:

• Click Read to move it to your Inbox containing read messages.

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see Setting up the 
default message options on page 83.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• If you want to move all the new messages, click Move all new messages to Inbox.

Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been read and moved from the 
list of new messages (refer to the previous section).

From the Inbox, you have the following options:

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see Setting up the 
default message options on page 83.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• Click Delete to delete the message. 

• Click Delete all messages in Inbox to delete all read messages in the Inbox. 

Note New messages cannot be deleted until they have been moved to the Inbox.
TT 98-123571-DraftA Handling messages 82



Chapter 5: Using the web interface
Configuring message settings

Setting up the default message options

You can set up general options for your outgoing messages. These settings apply by default to all 
your outgoing messages. Note, however, that you can change the Delivery notification setting for 
an individual message. For further information, see Sending an SMS message from the 
EXPLORER™ 300 on page 79.

Do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

2. If you want to include the original message when you reply, select Yes next to Include 
message in reply.

3. Select whether or not you want Delivery notification for SMS messages. 
If you click Yes, the Status column in the Sent folder will show the status of your message 
when it has been sent.

4. Click Apply.
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Viewing or changing SMS service center number

The SMS service center number identifies the SMS service center used when sending and 
receiving SMS messages. The SMS service center number is stored on the SIM card. 

• To see the SMS service center number, select 
MESSAGES > Message settings from the left navigation pane.

• To change the number, click Edit next to SMS service center, change the number and click 
Save. Then click Apply to apply all changes in the window. 

The SMS service center number is provided from your Airtime Provider.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice mails.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane.

Note The Voice mail number is only listed if it is available on the SIM card. Otherwise, refer to 
the information included with your Airtime subscription.
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EXPLORER™ 300 settings

Accessing the EXPLORER™ 300 settings

Select SETTINGS from the left navigation pane. The SETTINGS window contains the local settings of 
the EXPLORER™ 300. The next sections describe these settings.

Power up behavior

Pointing at power up

If the EXPLORER™ 300 is placed in a fixed position it may not be necessary to go through the 
pointing process every time the EXPLORER™ 300 is powered. You can set up the EXPLORER™ 300 
to automatically establish a connection to the BGAN network, if you know that the signal strength 
is sufficient.

1. In the Power up section of the SETTINGS window, select whether or not pointing is required at 
power up.

• To go through the pointing process every time the EXPLORER™ 300 is powered, select Yes.

• To have the EXPLORER™ 300 automatically register itself on the network every time the 
EXPLORER™ 300 is powered, select No.
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2. Click Apply.

If you have selected that pointing is not required at power up, the start up procedure will be as 
follows:

1. Power up.

2. Enter the PIN. After the PIN is accepted, the EXPLORER™ 300 immediately tries to connect to 
and register on the BGAN network.

Automatic power up

1. In the Power up section of the SETTINGS window, select whether or not the EXPLORER™ 300 
should switch on automatically when external power is applied.

• To have the EXPLORER™ 300 switch on automatically when external power is applied, 
select Yes.

• To have the EXPLORER™ 300 switch on only when the Power button is pressed, click No.

2. Click Apply.

Setting the display backlight and contrast

To set the display backlight and contrast, do as follows:

1. In the Backlight section of the SETTINGS window, set the timing.
The Timed period is the period of time the light will stay on after the last key is pressed.

2. Set the level of the backlight with the Set level scroll bar.

3. In the Contrast section, click Yes next to Automatic if you want the contrast to be adjusted 
automatically according to the temperature.
The contrast of the display changes with the temperature. The EXPLORER™ 300 can 
automatically adjust the contrast to compensate for these variations.

4. If you want to set the contrast manually, set the contrast level with the Set level scroll bar.

5. Click Apply.
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Turning audio indicators on or off

The EXPLORER™ 300 has audio indicators for different events or situations.

To enable or disable these audio indicators, do as follows:

1. In the Audio indicators section of the SETTINGS window, turn the audio indicators on or off 
using the radio buttons. Each audio indicator is explained below.

2. Click Apply.

The EXPLORER™ 300 has audio indicators for the following events:

• Pointing.
The Pointing sound is used during the pointing process. The frequency increases with the 
signal strength, to help you find the maximum signal strength when pointing the antenna. 
This setting is a default setting. When the EXPLORER™ 300 is in pointing mode, you can 
toggle pointing sound on/off for the current pointing process using  or on the keypad of 
the EXPLORER™ 300. However, the default setting applies at the next pointing process.

• Messages.
The Message indicator is a sound indicating that a message has arrived.

• Alarm.
The Alarm indicator is a sound indicating that an alarm is issued. 
An alarm is issued if the EXPLORER™ 300 detects an error that requires your action.

Enabling activation of stealth mode

In Stealth mode, the EXPLORER™ 300 operates with no sounds nor lights. However, it is still 
possible to operate the EXPLORER™ 300 and the display text is, in most cases, readable.

To enable the use of Stealth mode for the EXPLORER™ 300, do as follows:

1. Select SETTINGS from the left navigation pane.

2. In the Stealth mode section, click Enable.
If you click Disable, the Stealth mode function cannot be activated.

3. Click Apply.

Important Only enable activation of Stealth mode if you are going to use it. If Stealth mode is 
activated by mistake, it may be difficult to operate the EXPLORER™ 300.

Note This setting does not activate Stealth mode, it only enables the use of Stealth mode. 
To activate Stealth mode, press C+OK on the keypad.

To deactivate Stealth mode and return to normal function, press C+OK again.
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Setting up the interfaces

Enabling/disabling interfaces

By default, all interfaces are enabled. However, you can disable the LAN interface, the Bluetooth 
interface and/or the Phone interface in order to minimize power consumption.

The icons in the Icon bar at the top of the web interface shows interfaces that are enabled. Clicking 
an icon brings you to the window where you can set up the interface or enable/disable it.

1. Select SETTINGS > Interfaces from the left navigation pane.

2. In the Interfaces window, select Enabled or Disabled next to the interface you want to 
enable/disable.

3. Click Apply.
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Description of data settings

Introduction

There are several data parameters that can be set up in the web interface. This section gives an 
overview of these parameters.

APN (Access Point Name)

The APN is used by the EXPLORER™ 300 user to establish the connection to the required 
destination network. This means that the EXPLORER™ 300 must know the APN in order to be able 
to connect to the destination network. 
APNs are provided from the Airtime Provider. They may also be defined on the SIM card.

Header compression

The Header of a data packet contains control information belonging to that packet. The 
information in the Header can take up a considerable amount of bandwidth. In order to save 
bandwidth, you can use Header Compression, meaning you compress the header information, 
leaving some of the information out.

You can select whether or not to use Header Compression for your data transmission.

• Header Compression enabled: Recommended for low-noise applications.
If you select Header Compression enabled, you will be using less bandwidth on header 
information, leaving more bandwidth for the actual payload. 
However, if the environment is noisy, the system will have to retransmit information, and you 
may end up using more bandwidth than without Header Compression.

• Header Compression disabled: Recommended in noisy environments.
If Header Compression is disabled, the system will be less sensitive to noise.

Primary and secondary Profiles

A Profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in 
which data is transmitted on an interface. For example, a Profile is used to define whether a 
connection should be a Standard or Streaming connection.

You can select between a number of predefined Profiles or define your own Profiles for your data 
transmission.

In the EXPLORER™ 300, you need an Administrator password to define Profiles and Traffic Flow 
Templates.

Note If you have selected more than one Profile (one primary and one or more secondary 
Profiles) for an interface, you must define a Traffic Flow Template before you can 
establish a valid connection.
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Configuring the LAN interface

For an explanation of each of the data settings, see Description of data settings on page 89.

To configure the LAN interface, do as follows:

1. Select SETTINGS > Interfaces > LAN.

2. Select whether the LAN interface should be Enabled or Disabled.

3. Under IP Header compression, select Enabled or Disabled. For information on this setting, see 
Header compression on page 89.

4. Under DHCP status, enable or disable DHCP.
If you select Enabled, the internal DHCP server in the EXPLORER™ 300 is enabled.

CAUTION! If you are connected using LAN while changing the settings below, your 
changes may affect your current connection.
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5. Under Local IP address, type in the IP address and netmask for your EXPLORER™ 300.
This is the local IP address for your EXPLORER™ 300 when it is in Router mode.

6. Under TCP/IP, select whether your computer uses a Dynamic IP address or a Static IP address. 
If you are using a static address, type in the address.
This is the IP address used externally on the satellite network.
To check this setting on your computer, see the TCP/IP properties of the LAN connection.

7. Select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special requirements, it is 
recommended to use the SIM default, or to set the common APN to SIM default, and then 
select Common here. You have the following options:

• Common. The APN is taken from the Common APN defined under 
SETTINGS > Interfaces > Common. Refer to Setting a common APN on page 99.

• SIM default. The APN is taken from the SIM card.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime Provider.

8. If your APN uses a password, type in the user name and password provided from the Airtime 
Provider.

9. Select the Primary Profile.

Select a Profile from the Primary scroll list. This Profile is used by the LAN interface as a first 
choice, when possible. 
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There are 3 predefined Profiles: Standard, Streaming 32 kbps and Streaming 64 kbps. 
Additionally, you can define your own custom Profiles.

For further information on Profiles and Traffic Flow Templates, see Using Profiles on page 106 
and Using a Traffic Flow Template on page 109.

10. Select the Secondary Profile.
To select more than one secondary Profile, press and hold Ctrl or Shift while selecting.

The Context Identifiers (CIDs) for the selected primary and secondary Profiles are listed under 
Profile CIDs.

11. Click Apply.
Your LAN settings are applied. Note that changes to your Profiles are not activated until you 
click Activate.

12. Click Activate if you want to activate the changes to your Profiles.

Important If you have selected a Streaming connection as your Primary Profile, the LAN 
interface will be running a Streaming connection until you select another 
Profile or disconnect the interface. However, if you select one or more 
Secondary Profiles, you can set up your Traffic Flow Template so that it will only 
use the Streaming Profile for certain types of traffic.

Note If you have selected both a Primary and one or more Secondary Profiles you 
must define a Traffic Flow Template before you can establish a valid 
connection.
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Configuring the Bluetooth interface

For an explanation of each of the data settings, see Description of data settings on page 89.

To configure the Bluetooth interface, do as follows:

1. Select SETTINGS > Interfaces > Bluetooth.

2. Under BLUETOOTH VOICE DEVICES, the voice devices paired with the EXPLORER™ 300 are 
listed. For each voice device in the list, check Standard if you want to be able to receive calls 
on that device.
Only calls with Standard call type are accepted.

3. Under DIAL-UP NETWORK DEVICES, the settings for paired data devices are listed. The next 
steps describe the settings that are available.

4. Under IP Header compression, select Enabled or Disabled.
For information on Header Compression, see Header compression on page 89.
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5. Under TCP/IP, select whether your computer uses a Dynamic IP address or a Static IP address. 
If you are using a static address, type in the address.
This is the IP address used externally on the satellite network.
To check this setting on your computer, see the TCP/IP properties of the Bluetooth connection.

6. Under APN, select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special requirements, it is 
recommended to use the SIM default, or to set the common APN to SIM default, and then 
select Common here. You have the following options:

• Common. The APN is taken from the Common APN defined under 
SETTINGS > Interfaces > Common. Refer to Setting a common APN on page 99.

• SIM default. The APN is taken from the SIM card.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime Provider.

7. If your APN uses a password, type in the user name and password provided from the Airtime 
Provider.

8. Select the Primary Profile.
Select a Profile from the scroll list. This Profile is used by the Bluetooth interface as a first 
choice, when possible.
There are 3 predefined Profiles: Standard, Streaming 32 kbps and Streaming 64 kbps. 
Additionally, you can define your own custom Profiles.

For further information on Profiles and Traffic Flow Templates, see Using Profiles on page 106 
and Using a Traffic Flow Template on page 109.

9. Select the Secondary Profile.

10. Click Apply.

Important If you have selected a Streaming connection as your Primary Profile, the 
Bluetooth interface will be running a Streaming connection until you select 
another Profile or turn off the interface. However, you can set up your Traffic 
Flow Template so that it will only use this Profile for certain types of traffic.

Note If you have selected both a Primary and one or more Secondary Profiles you must 
define a Traffic Flow Template before you can establish a valid connection.
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Pairing Bluetooth devices from the web interface

What is pairing?

Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate with one 
another. When this happens, the two devices exchange passkeys and join a pair. The pairing 
process only takes place the first time the two devices are connected. Once the two devices have 
established a pair, they automatically accept communication when one device recognizes the 
other device.

Preparing the EXPLORER™ 300 for Bluetooth pairing

To prepare the Bluetooth interface on the EXPLORER™ 300, do as follows:

1. Connect a computer to the EXPLORER™ 300, e.g. using the LAN interface.

2. Access the web interface from your connected computer.
Refer to The web interface on page 67.

3. In the web interface, select SETTINGS > Interfaces > Bluetooth and make sure that Bluetooth 
is Enabled.

4. Use the predefined Device name or type in a new name for your EXPLORER™ 300. 
The Device name is shown to other Bluetooth devices, if the EXPLORER™ 300 is configured to 
be shown (refer to step 6. below).

5. Use the predefined Default passkey or type in a new one.
This passkey is used by default when pairing devices with the EXPLORER™ 300.

6. Next to Visibility, select Show or Hide.
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• If you select Show, the device name of the EXPLORER™ 300 is shown to other Bluetooth 
devices that are searching for devices.

• If you select Hide, other Bluetooth devices will not see the EXPLORER™ 300.

7. Click Apply at the bottom of the window.

Pairing from your Bluetooth device

For information on how to pair devices from your Bluetooth device, see Pairing devices in which 
you can enter a passkey on page 50.

Pairing devices with a fixed passkey

Some Bluetooth devices, such as headsets, do not provide the possibility to enter a passkey for 
connecting to another device. These devices have a fixed passkey which must be entered on the 
other device. This section describes how to pair such devices with the EXPLORER™ 300.

Do as follows to pair the devices:

1. Connect a computer to the EXPLORER™ 300, e.g. using the LAN interface.

2. Start up the EXPLORER™ 300.
Refer to Getting started on page 11.

3. Turn on Bluetooth on your Bluetooth device and place it close to the EXPLORER™ 300.

4. Access the web interface from your connected computer.
For further information, see The web interface on page 67.

5. Select SETTINGS > Interfaces > Bluetooth and make sure that Bluetooth is Enabled.

6. From the left menu of the Bluetooth window, select Add device.
Note that you can pair maximum 2 devices. If you have already paired 2 devices, you have to 
unpair a device before you can pair a new one. For information on how to unpair devices, see 
Unpairing devices on page 97.

7. Click Search.
The EXPLORER™ 300 now searches for Bluetooth devices.

8. Click Update.

9. When the device you want to pair appears in the list, click Pair next to the device.

10. Enter the passkey of your Bluetooth device. 

Note The method for pairing devices may vary depending on your Bluetooth device. Consult 
your Bluetooth device documentation for information.

Note The search procedure can take up to 2-3 minutes. The list is not updated 
dynamically. Click Update to see new found devices.
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The default passkey for a Bluetooth headset is often 0000. Otherwise, refer to the manual for 
your Bluetooth device.

11. When you are prompted from the Bluetooth device, usually by a tone, press the button on the 
device to accept pairing.

The new device should now be paired with the EXPLORER™ 300 and added to the list of Paired 
devices. This list is accessed from the left menu of the Bluetooth window in the web interface.

As long as the Bluetooth device is in the list of Paired devices, you can always reconnect the 
device to the EXPLORER™ 300 without further setup.

Viewing paired devices

To see a list of devices that are paired with the EXPLORER™ 300, do as follows:

1. Access the web interface.
Refer to The web interface on page 67.

2. Select SETTINGS > Interfaces > Bluetooth > Paired devices.

The list shows devices that are paired with the EXPLORER™ 300. You can see the name, Class of 
Device, status (whether or not a device is currently connected) and local phone number.

You can also see paired devices in the display. Select PROPERTIES > BLUETOOTH 
DEVICES in the display menu system to see a list of all paired devices.

Unpairing devices

To remove a device from the list of Paired devices, do as follows:

1. Access the web interface and select 
SETTINGS > Interfaces > Bluetooth > Paired devices.

2. In the Paired devices list, click Unpair next to the device you want to remove.

When the device is removed from the list, you have to pair it with the EXPLORER™ 300 again to 
make a connection.

Note If you need to unpair an EXPLORER™ Bluetooth Handset, make sure the handset is 
connected to the EXPLORER™ 300 while you unpair it. 

If you select Unpair while the handset is not connected, it will automatically be 
paired again when it approaches the EXPLORER™ 300.
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Configuring the Phone interface

Do as follows:

1. Select SETTINGS > Interfaces > Phone from the left navigation pane.

2. Select Enabled or Disabled to enable/disable the Phone interface.

3. Check Standard if you want to be able to receive calls through the Phone interface.
Only calls with Standard call type are accepted.

4. Click Apply.
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Setting a common APN

Setting the common APN

The common APN setting is defined here and can be selected for each interface. If you are using 
the same APN for the Bluetooth and LAN interfaces, it is easier to define it once, and then simply 
select it for the relevant interfaces. Also, if you change the common APN at a later stage, it is 
automatically updated for all interfaces where the Common setting is selected.

To set a common APN, do as follows:

1. Select SETTINGS > Interfaces > Common.

2. Select the APN. You have the following options:

• SIM default. The APN is taken from the SIM card. This is the recommended option, unless 
you have special requirements.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime Provider.

3. If your APN uses a password, type in the user name and password provided from the Airtime 
Provider.

4. Click Apply.

How to use the common APN

When you configure your individual interface, select Common to use the setting from this window. 

Where Common is selected in the individual interface settings, the setting will automatically be 
updated when the Common APN is changed.
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Properties, software upload and alarm list

Viewing the properties of the EXPLORER™ 300

To view the properties of the EXPLORER™ 300, select PROPERTIES from the left menu.

The PROPERTIES window shows:

• Local IP address. The local IP address of the EXPLORER™ 300. 

• IMEI number. The IMEI number (International Mobile Equipment Identity) of the 
EXPLORER™ 300. This is a unique number that identifies your EXPLORER™ 300. The IMEI 
number is also printed on the serial number label at the back of the terminal.

• SMS service center. A number used to identify the SMS service center used by your 
EXPLORER™ 300 to send and receive SMS messages.

• Mobile subscriber numbers (if available on SIM card). The numbers to use when calling the 
EXPLORER™ 300.

• Software version. The version of the software embedded in the EXPLORER™ 300.

• Unit serial number. The serial number of the total unit.

• PCB numbers. The numbers of the PCBs in the EXPLORER™ 300.

• MAC address of the EXPLORER™ 300.
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Uploading software

You can upload software to the EXPLORER™ 300 without entering the PIN. However, if the PIN is 
not entered, you must enter the Administration user name and password.

To upload software to the EXPLORER™ 300, do as follows:

1. Acquire the new software version from Thrane & Thrane and save it on your computer.

2. In the web interface, select PROPERTIES from the left navigation pane.
The Software version field shows the current software version.

3. Click Upload from the left navigation pane.
If you have not entered the PIN at start-up, you are prompted for an Administration user 
name and password. 

4. If required, type in the Administration user name and password and click Logon.
The default user name is admin and the default password is 1234.

5. Click Browse...

6. Browse to the new software version and accept it.

7. Click the Upload button.
Note that the upload procedure takes a couple of minutes. 

Note When upload is done, your EXPLORER™ 300 automatically restarts with the new 
software.
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Viewing the Alarm List

When an alarm is issued, the web interface shows an alarm icon in the icon bar.

To view the Alarm list, click the alarm icon from the icon bar at the top of the web interface or 
select Properties > Alarm list from the left navigation pane.

The Alarm list window shows a detailed list of active alarms including the time of the first 
occurrence, ID and severity of the alarm message, number of occurrences and a short text 
describing the error. For more information on the alarm messages, refer to Alarm messages on 
page 122.

If you need to report the alarms for service purposes, make sure you include the complete ID 
number. This number is used by service personnel to uniquely identify an alarm.
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Administration

Accessing the administration settings

Logging on

The Administration settings require an Administration user name and password. 

1. Select ADMINISTRATION from the left navigation pane.

2. Enter the Administration user name and password. 
The default user name is admin and the default password is 1234.

The next section explains how to change the user name and password.

3. Click Logon.
The Administration window is now updated to let you change the user name and password, 
Save/load a configuration or log off Administration.
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Changing the administration password

Do as follows:

1. After entering the Administration user name and password in the ADMINISTRATION window, 
locate the section Change administrator logon.

2. Type in the existing user name.

3. Type in the new password twice.

4. Click Change.
At the next logon the new password is required.

Saving a configuration to a file

If you need to reuse a configuration in another EXPLORER™ 300, you can save your current 
configuration to a file, which can then be loaded into the other EXPLORER™ 300.

Do as follows:

1. In the ADMINISTRATION window, under Configuration, click Save.

2. Accept the default destination file name or type in the destination file name and location.

3. Click OK.
The configuration is now saved to a file. This file is used to load the configuration into another 
EXPLORER™ 300. See the next section.
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Loading a configuration from a file

1. In the ADMINISTRATION window, under Configuration, click Load.

2. Click Browse... to browse to the file you want to import. Then click Open.

3. Click Load.
The new configuration is now loaded into your EXPLORER™ 300.

Logging off administration

If you have not entered anything for 30 minutes under ADMINISTRATION, you are logged off 
automatically.

To log off manually, click Logoff under Administrator logoff in the ADMINISTRATION window.

Call charges

If you know the tariff for your subscribed services, you can enter these tariffs in the web interface 
and automatically calculate the charges for your calls and data sessions.

Do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Call Charges.

2. Select the currency from the Currency drop-down list.

3. Enter the tariff for each of the services.

4. Click Apply.
The entered tariffs are used for estimating the charges for calls and data sessions. The 
estimated charge is listed for each call or data session in the call log. For further information, 
see Viewing the lists of calls on page 78.

Log handling

1. From the left navigation pane in the ADMINISTRATION window, select Log Handling.

2. To clear the Call log, click OK next to Clear call log?. 

3. To clear the total counters, click OK next to Clear total counter?.
This will reset the Time connected counters on the Calls page.

Note Thrane & Thrane does not take responsibility for the correctness of the estimated 
charges. This calculation is only a rough estimate of the charge, based on the tariff 
entered by the user. Also, the Airtime Provider may have different methods of calculating 
the charge.
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Using Profiles

What is a Profile?

A Profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in 
which data is transmitted on an interface. For example, a Profile is used to define whether the 
connection is a Streaming connection or a Standard connection.

You can select between a number of predefined Profiles or define your own Profiles for your data 
transmission.

If no Traffic Flow Template (TFT) is defined, the Primary Profile for an interface is used for all traffic 
on that interface. See What is a Traffic Flow Template? in the next section. 

For further information on Profiles, refer to the 3GPP standard TS 23.107.

Selecting the Profiles for an interface

When you set up your interface, you select the Profiles to use for that interface. You select a 
Primary Profile and optionally one or more Secondary Profiles.

For further information on how to select the Profiles, see the “Configuring...” sections for the 
individual interfaces in this chapter.
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Defining new Profiles

When you define your Profiles you can select Subscribed for many of the settings. If you select 
Subscribed, the value given in your Airtime subscription will automatically be used.

To define a new Profile, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Profiles.

2. In one of the User defined columns, fill in the top field with the name of your Profile.

3. In the Traffic class row of your new Profile, select a class from the drop-down list.
You may select one of the following:

• Conversational is real-time two-way conversation. It is primarily used for voice over IP and 
video conferencing.

• Streaming is real-time one-way communication. It is primarily used for video and audio.

• Interactive is two-way communication (not real-time). It is used for communication that is 
not very delay-sensitive, such as web browsing, data base retrieval and server access. 
Examples of machines interaction with remote equipment are: polling for measurement 
records and automatic data base enquiries (tele-machines).

• Background is used for data which is not delay-sensitive, such as E-mails, SMS, download 
of databases and reception of measurement records.
TT 98-123571-DraftA Administration 107



Chapter 5: Using the web interface
4. Type in the bit rates in kbps in the following rows:

• Maximum bit rate ul (kbps) is the maximum upload bit rate allowed for this Profile.

• Maximum bit rate dl (kbps) is the maximum download bit rate allowed for this Profile.

• Guaranteed bit rate ul (kbps) is the guaranteed upload bit rate needed for this Profile.

• Guaranteed bit rate dl (kbps) is the guaranteed download bit rate needed for this Profile.

5. In the Delivery order row, select from the scroll list whether or not data should be delivered in 
the same order it was sent. Yes means the data packets are delivered in the same order they 
were sent.

6. In the Maximum SDU size (byte) row, type in the maximum allowed packet size in Bytes 
(rounded off to nearest 10). The maximum packet size possible is 1520.

7. In the Delivery of erroneous SDUs row, select one of the following from the list:

• Yes means packets are allowed to contain errors. This setting is suitable for delay-sensitive 
transmission, because the need for retransmission is limited. The SDU Error settings in step 
8. and step 9. will apply.

• No means packets are not allowed to contain errors, and the SDU Error setting in step 8. 
will not be applied. This setting is suitable where error-free transmission is important and 
delays are accepted.

• No detect means that errors will not be detected, and the SDU Error setting in step 8. will 
not be applied.

8. If you selected Yes in step 7., select from the SDU error ratio drop-down list the fraction of a 
packet allowed to be lost or erroneous.

9. Select from the Residual bit error ratio drop-down list the undetected bit error ratio of a 
packet. If no error detection is requested, Residual bit error ratio indicates the bit error ratio 
in the delivered packets.

10. In the Transfer delay (ms) row, type in the delay in ms. This is the delay from data is received 
in the EXPLORER™ 300 until it arrives at the receiving end.

11. In the Traffic handling priority row, select from the drop-down list which priority this 
connection should have.

12. Click Apply.
The new Profile is now added, and can be selected from the lists of primary and secondary 
Profiles when you set up your interfaces.

Important For best performance, choose the right traffic class for your application. In 
general, Standard data (Background) is best suited for TCP/IP applications, and 
Streaming data is best suited for UDP traffic, e.g. live video or audio.

Note When you click Apply, the bit rate values you typed in may be rounded off because 
only certain values are allowed.
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Using a Traffic Flow Template

What is a Traffic Flow Template?

A Traffic Flow Template (TFT) is a packet filter list allowing the Core network and the 
EXPLORER™ 300 to classify packets received from the external network into the proper PDP 
(Packet Data Protocol) context.

A TFT consists of from one and up to eight packet filters, each identified by a unique packet filter 
identifier. A packet filter also has an evaluation precedence index that is unique within all TFTs 
associated with the PDP contexts that share the same PDP address.

Information of source, destination, type of service etc. is combined in each packet filter in the TFT.

Purpose of the Traffic Flow Template

The purpose of the TFT is to assign different priorities to different types of traffic, in order to 
optimize performance.

Example: When you are browsing the Internet, a Standard data connection will normally be 
sufficient. However, if you need to have a video conference, you may need to use a 
Streaming connection, in order to obtain a direct connection without interruptions. Your 
Traffic Flow Template can define these priorities, so that your connection automatically 
switches to Streaming e.g. when you have a video conference.

Defining the Traffic Flow Template

To define a new template, do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Traffic Flow Templates.

2. Select which filters should apply to which Profiles.
The filters are defined in the Traffic flow filters list. Refer to the next section 

3. Click Apply.
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Defining filters for the Traffic Flow Template

To define the filters used in the Traffic flow template, do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Traffic Flow Templates > Traffic flow filters.

Then fill in the details for each traffic flow filter as described below.

2. Type in an Evaluation Precedence Index in the Eval.Prec. Index column.

3. Fill in one or more of the following fields to define the filter.
The allowed ranges appear in hover text when you pass the mouse over the fields.

• Source address + Subnet mask.

• Protocol number.

• Destination port range (From and To).Note that Source and Destination are relative the core 
network. This means that Destination is your EXPLORER™ 300 terminal.

• Source port range (From and To).

• Type of Service + Type of Service mask.

For further information on the principles and parameters of the Traffic Flow Template, refer to 
the 3GPP standards TS27.007 V4.2.0 and TS 23.060 V4.7.0.

4. Click Apply at the bottom of the window.
The new settings are included if you select the filter in the Traffic flow template window.

Note This field is mandatory. Each filter must have a different index. 
TT 98-123571-DraftA Administration 110



Chapter 5: Using the web interface
Help desk and diagnostic report

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By default, the Help desk 
is the phone number for your Airtime Provider, if it is available on the SIM card.

Select HELP DESK from the left navigation pane.

If the Help desk number is available on the SIM card, the number is displayed as a link. To change 
the number, click the link, change the number and click Apply.

If you need help with EXPLORER™ 300 issues you should call your local distributor.

Generating a diagnostic report

If you want to generate a diagnostic report, do as follows:

1. Click Generate report from the HELP DESK window. 
In some browsers the file may open directly in your browser. If it does, choose File > Save As 
to save the file.

2. Choose a location for the file and save it.

The diagnostic report contains relevant information for troubleshooting. Please enclose this file 
when you are reporting an error.

What’s next?

This chapter has explained how to use the web interface for setup and use of the EXPLORER™ 300. 
You should now be able to set up the EXPLORER™ 300, pair Bluetooth devices, check status, read 
and send SMS messages, use the phone book and much more.

The following chapter, Maintenance and troubleshooting, provides guidelines for troubleshooting 
and for general maintenance.
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Chapter 6
Maintenance and troubleshooting 6

In this chapter

This chapter gives guidelines for troubleshooting and for general maintenance. It also provides an 
overview of the different means of status signaling,

Getting support

Overview

If this manual does not provide the information required to solve your problem, you may want to 
contact your Airtime Provider or your local distributor.

Airtime support

If you need assistance from your Airtime Provider, please call the help desk. 
To see the help desk number, enter the display menu system or the web interface of your 
EXPLORER™ 300 and select HELP DESK. This help desk number is either taken from the SIM card 
or entered manually. If no number is available under HELP DESK, check your Airtime subscription 
for a contact number.

EXPLORER™ 300 support

If you need assistance with problems caused by the EXPLORER™ 300, please call a distributor in 
your area. 

Click this link to see a list of Thrane & Thrane distributors.

Note The list of distributors is located on the EXPLORER™ 300 CD-ROM delivered with your 
EXPLORER™ 300, so it may not always be up to date.

An updated list is available on Thrane & Thrane’s web site: www.thrane.com. 
Click Land Mobile and select Distributors from the top menu bar.
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Uploading software

Viewing software version status

To view the version of the embedded software in the EXPLORER™ 300, select PROPERTIES in the 
web interface or in the display menus and see Software information.

Uploading software using the web interface

You can upload software from the PROPERTIES > Upload window in the web interface. 

If you have an Administrator user name and password you do not need to insert a SIM card nor to 
enter the PIN to be able to upload software.

For further information, see Uploading software on page 101.

Maintenance

Normal use of the battery

It is recommended not to partially charge/discharge the battery several times in a row. Partial 
charging/discharging affects the accuracy of the capacity measurement.

Never leave the battery fully discharged for a longer period of time. If the battery is not to be used 
for a shorter period of time (1 month), charge the battery to minimum 20 to 30% and remove it 
from the EXPLORER™ 300. If the Battery is stored for more than a month, see Storage at the end of 
this section.

Recharging the battery

To recharge the battery, insert it into the EXPLORER™ 300 and connect the EXPLORER™ 300 to 
power. 

The indicator left to the display is constantly green as long as the battery is charging. When the 
battery is fully recharged, the green indicator is turned off. If the EXPLORER™ 300 is switched on, 
the green indicator will be flashing shortly every 2 seconds.

If a charging error occurs, the green indicator on the EXPLORER™ 300 flashes rapidly. See the 
Troubleshooting Guide on page 116.
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Accurate display of the battery capacity

To ensure accurate display of the battery capacity, it is recommended to run a “learning cycle” for 
every 100 recharge/discharge and at first time use. The learning cycle must be performed at 20°C-
30°C.

A learning cycle is performed as follows:

1. Fully charge the battery.

2. Remove external power and fully discharge the battery:
Use the EXPLORER™ 300 and/or leave it on until it turns off automatically.
This way the EXPLORER™ 300 “learns” the complete capacity of the battery.
 Note that it may take up to 36 hours to discharge the battery if it is not in use.

3. Recharge the battery.

Storage

Do not leave the battery inserted in the EXPLORER™ 300 during storage.

If the battery is not to be used for a longer period of time, do as follows:

1. Fully charge the battery.

2. Remove external power. Then use the EXPLORER™ 300 or leave it on until the display shows a 
battery capacity of approximately 50%.

3. Switch off the EXPLORER™ 300.

4. Remove the battery and store it. 

In this condition the battery can be stored for approximately 1 year at 20°C to 30°C. After 1 year you 
must recharge the battery. For further information on storage temperature, see Battery on 
page 129.

Disposal of the EXPLORER™ 300

Old electrical and electronic equipment marked with this symbol can 
contain substances hazardous to human beings and the environment. 
Never dispose these items together with unsorted municipal waste 
(household waste). 

In order to protect the environment and ensure the correct recycling of old equipment as well as 
the re-utilization of individual components, use either public collection or private collection by the 
local distributor of old electrical and electronic equipment marked with this symbol. 

Contact the local distributor for information about what type of return system to use. 

Important Switch off the EXPLORER™ 300 before removing the battery!
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Options and accessories

The following options and accessories are available from Thrane & Thrane:

Item Number

EXPLORER™ Bluetooth Handset + charger cable
TT-3625A

Desktop charger cradle for EXPLORER™ Bluetooth 
Handset + power supply

TT-3625A, Opt. 003

EXPLORER™ 2-wire phone + cable TT-3625B

EXPLORER™ 300 Battery 
TT-3686L

EXPLORER™ 300 Dummy Battery TT-3686F

EXPLORER™ 300 Softbag   
TT-3650A, Opt. 202 

EXPLORER™ 300 Car charger cable
TT-3650A, Opt. 009

EXPLORER™ 300 AC/DC adapter 
TT-3682L

UP0501Q-15P 

Pole mount kit for EXPLORER™ 300 TT-3650A, Opt. 922
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Troubleshooting guide

The below table provides information on some of the problems that might occur, including 
possible causes and remedies to solve the problems.

Problem Possible Cause Remedy

The EXPLORER™ 300 
cannot be switched 
on, or does not stay 
on when powered by 
the battery.

The battery needs 
recharging.

Recharge the battery. Check the battery 
indicator in the display.

The battery is not inserted 
properly.

Remove the battery and re-insert it. 
Make sure the battery is inserted 
properly and that the latch is locked.

The battery contacts are 
dirty or damaged.

Clean the battery contacts if necessary. 
If the contacts are damaged, replace the 
battery.

There is no light in 
the power indicator 
nor in the display 
when the 
EXPLORER™ 300 is 
switched on.

The EXPLORER™ 300 may 
be in Stealth Mode (all 
lights and sounds are off).

Press C+OK on the display keypad. This 
will toggle Stealth Mode on/off.

The EXPLORER™ 300 
cannot be switched 
off.

The Power button was not 
pressed long enough.

When you switch off the 
EXPLORER™ 300, hold the Power 
button until the display shows 
“Switching off”.

In rare cases, it may take up to 10 
seconds to switch off the 
EXPLORER™ 300.

Charging error -

The green Power 
indicator flashes 
rapidly while the 
battery is being 
recharged.

The temperature is below 
0°C or above 45°C.

Only charge the battery when the 
temperature is within the range 0°C to 
45°C.

The charging voltage is 
less than 9 V.

Wait until charging begins (the green 
Power indicator lights constantly). 

If the battery is completely discharged, 
and it has been out of use for a long 
time, the charging process may take a 
long time to start. If charging does not 
begin within 2-3 hours, contact your 
local distributor, or purchase a new 
battery.
TT 98-123571-DraftA 116



Chapter 6: Maintenance and troubleshooting
The display shows 
INSERT SIM.

The SIM card is not 
present.

Remove the battery and insert the SIM 
card in the SIM slot according to the 
instructions in the section Inserting the 
SIM card on page 12.

The SIM card is not 
inserted properly.

Remove the SIM card and re-insert it 
according to the instructions in the 
section Inserting the SIM card on 
page 12.

The display shows 
NO GPS.

The EXPLORER™ 300 is 
unable to register on the 
network, because the GPS 
position is unknown.

Make sure the view to the GPS satellites 
is not blocked. 

To obtain GPS fix, the EXPLORER™ 300 
should be placed flat on an even 
surface pointing straight upwards, with 
a clear view to as much of the sky as 
possible. When the EXPLORER™ 300 
has obtained GPS fix, you can point the 
antenna towards the BGAN satellite.

To see the GPS status, enter the menu 
system and select PROPERTIES > 
GPS STATUS.

The display shows
EMERGENCY 
ONLY.

The BGAN network is only 
available for emergency 
calls. 

The reason may be one of 
the following:

1) You have pressed C on 
the EXPLORER™ 300 
instead of entering the PIN.

2) Your Airtime 
subscription has expired.

3) You are using the wrong 
SIM card.

1) If the display reads “ENTER PIN?” 
and/or you cannot enter the display 
menu system, you may have pressed C 
instead of entering the PIN. Unless the 
use of PIN is disabled, e.g. from the 
BGAN LaunchPad, you must enter the 
PIN before you are allowed make calls. 

2) Check your subscription with the 
Airtime Provider.

3) Check that your SIM card is valid for 
communication on the BGAN network. 

The display shows
NOT 
REGISTERED.

The EXPLORER™ 300 
cannot register on the 
BGAN network.

Check that your SIM card is valid for 
communication on the BGAN network.

Check your subscription with the 
Airtime Provider.

Problem Possible Cause Remedy
TT 98-123571-DraftA 117



Chapter 6: Maintenance and troubleshooting
The EXPLORER™ 300 
cannot obtain its 
position using GPS.

There is no GPS signal, or 
the signal is weak.

If the EXPLORER™ 300 has 
not been used recently 
within the same location, it 
can take up to 10 minutes 
to obtain the GPS position.

Check the GPS status in the display or 
the web interface. 

To help the EXPLORER™ 300 obtain GPS 
fix, it should be placed flat on an even 
surface pointing straight upwards, with 
a clear view to as much of the sky as 
possible. 

When the EXPLORER™ 300 has 
obtained GPS fix, you can point the 
antenna towards the BGAN satellite.

No signal or weak 
signal from the BGAN 
satellite.

The view to the satellite is 
blocked.

Make sure the EXPLORER™ 300 has a 
clear view to the satellite. Be aware that 
window glass, trees, or even rain may 
reduce the signal level.

The antenna is pointed in 
the wrong direction.

Check that the antenna is pointed 
according to the position data.

Adjust the position to the highest 
possible signal strength.

Connection to the 
Internet cannot be 
established.

The signal strength is too 
low.

Check that the antenna is pointed 
according to the position data.

Adjust the position to the highest signal 
strength you can obtain.

As a rule of thumb, you should have a a 
signal strength of 41 dBHz or more to be 
able to make a call or data session.

Your connection is defined 
as a dial-up connection, 
but you have not opened 
the dial-up connection.

You need to open the dial-up 
connection before you can connect to 
the Internet.

Your connection is a dial-
up connection, but you 
have not entered the 
phone number *98# to 
indicate a connection to 
the Internet.

Change the phone number in the dial-
up connection to *98# and open the 
dial-up connection before accessing the 
Internet.

Problem Possible Cause Remedy
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The web interface 
cannot be accessed.

The browser is configured 
to use a proxy server.

For Microsoft Internet Explorer, select 
Tools > Internet Options > Connections > 
LAN Settings and uncheck Use a proxy 
server for your LAN.

You have entered a wrong 
IP address.

Check the IP address and re-enter it.

Your connection is defined 
as a dial-up connection, 
but you have not opened 
the dial-up connection.

You need to open the dial-up 
connection before you can connect to 
the Web server.

Your connection is a dial-
up connection, but you 
have not entered the 
phone number *98# or 
*99# to indicate 
connection to the Internet 
and/or the web interface.

Change the phone number in the dial-
up connection to *98# or *99# and 
open the dial-up connection before 
accessing the web interface.

A Phone connection 
cannot be 
established.

The interface is disabled in 
the EXPLORER™ 300.

Enable the interface by entering the 
display menu system and selecting 
SETTINGS > INTERFACES > 
PHONE > ON, or

by accessing the web interface and 
selecting SETTINGS > interfaces > 
Phone > Enabled

The cable is not properly 
connected.

Connect the cable.

The cable type or 
connector type is not 
correct.

For information on the correct type of 
connector and cable, refer to Phone 
interface on page 131.

Incoming calls: The voice 
quality used for the call is 
not selected in the web 
interface.

Make sure the voice quality used for 
calls to the EXPLORER™ 300 is selected 
in the web interface. Access the web 
interface and select SETTINGS> 
Interfaces > Phone. Then select the 
voice quality for incoming calls.

Problem Possible Cause Remedy
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A Bluetooth handset 
connection cannot be 
established.

The interface is disabled in 
the EXPLORER™ 300.

Enable the interface by entering the 
display menu system and selecting 
SETTINGS > INTERFACES > 
BLUETOOTH > ON, or

by accessing the web interface and 
selecting SETTINGS > interfaces > 
Bluetooth > Enabled

The Bluetooth handset is 
placed too far away from 
the EXPLORER™ 300.

Bring the handset closer to the 
EXPLORER™ 300. 

Note that the specified maximum 
distance is only valid under ideal 
conditions.

The handset is not yet 
paired with the 
EXPLORER™ 300.

Pair the devices. Refer to Making a call 
to the EXPLORER™ 300 on page 55.

Incoming calls: The voice 
quality used for the call is 
not selected in the web 
interface.

Make sure the voice quality used for 
calls to the EXPLORER™ 300 is selected 
in the web interface. Access the web 
interface and select SETTINGS > 
Interfaces > Bluetooth. Under 
BLUETOOTH VOICE DEVICES locate the 
relevant handset and select the right 
voice quality for incoming calls.

A LAN connection 
cannot be 
established.

The interface is off in the 
EXPLORER™ 300.

Enable the interface by entering the 
display menu system and selecting 
SETTINGS > INTERFACES > LAN > 
ON, or

by accessing the web interface and 
selecting SETTINGS > interfaces > LAN > 
Enabled

The cable is not properly 
connected.

Connect the cable.

The cable type or 
connector type is not 
correct.

For information on the correct type of 
connector and cable, refer to LAN 
interface on page 132.

Problem Possible Cause Remedy
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A Bluetooth data 
connection cannot be 
established.

The interface is off in the 
EXPLORER™ 300.

Enable the interface by entering the 
display menu system and selecting 
SETTINGS > INTERFACES > 
BLUETOOTH > ON, or

by accessing the web interface and 
selecting SETTINGS > interfaces > 
Bluetooth > Enabled.

The computer is placed too 
far away from the 
EXPLORER™ 300.

Bring the computer closer to the 
EXPLORER™ 300. 

Note that the specified maximum 
distance is only valid under ideal 
conditions.

The computer is not yet 
paired with the 
EXPLORER™ 300.

Pair the devices. Refer to Making a call 
to the EXPLORER™ 300 on page 55.

The requested Bluetooth 
profile is not supported, or 
is not activated on the 
computer.

Check the Bluetooth installation on your 
computer to see if the profile is 
supported and activated.

Problem Possible Cause Remedy
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Status signaling

There are many ways of troubleshooting if an error occurs. The EXPLORER™ 300 has different 
means of status signaling, to help you find the cause of a problem:

• Indicators.
The function of the light indicators next to the 
display is described in Light indicators on page 8. 

• Alarm messages. 

• Log files.

Alarm messages and log files are described in the following sections.

Alarm messages

Display of alarm messages

The EXPLORER™ 300 can detect errors during POST (Power On Self Test) or CM (Continuous 
Monitoring). When the EXPLORER™ 300 detects an error that requires your action, it issues an 
alarm.

When alarms are issued in your EXPLORER™ 300, the 
display indicates the number of new alarms, and the 
red message indicator is flashing.

You now have the following options:

• Press C to ignore the alarm message and continue from where you were before the alarm was 
issued.

• Press OK to enter the alarm list showing all active alarms. The alarms are listed with their ID 
numbers. 
To see the name and time stamp of the alarm, press OK again. 
Use  and  to scroll through the name, ID and time stamp. If the text is too long, press OK 
( ) to scroll through the rest of the text.

As long as the cause of an alarm is still present, the Main screen shows VIEW ALARM LIST? 
If you press OK, the list of currently active alarms appears.

Explanations for the alarms and remedies to solve the problems are listed in the next section.

All alarms are logged in the alarm log. For information on the alarm log, see Alarm log on 
page 127. 
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List of alarms

The following list explains the alarms that may show in the display and in the web interface of the 
EXPLORER™ 300.

Note In the display and in the web interface the ID includes a hyphen followed by a control-
digit at the end. This digit is used to make sure the ID is not misinterpreted when passed 
on, e.g. to service personnel. Make sure you include the entire number when contacting 
your distributor.

ID Alarm Text Explanation Remedy

00100 to 
00199

System Data 
Damaged

Important system data is 
damaged

Do not use the 
EXPLORER™ 300. Contact 
your distributor.

00200 to 
00209

Battery Error Error during 
communication with the 
battery

Only use the 
EXPLORER™ 300 with 
external power supply. 
Contact your distributor.

00210 to 
00219

SIM Module 
Error

The SIM interface on the 
EXPLORER™ 300 cannot be 
used.

Contact your distributor.

00230 to 
00239

Temperature 
Sensor FATAL

The system is in danger of 
overheating.

Do not use the 
EXPLORER™ 300. Contact 
your distributor.

00240 to 
00249

Temperature 
Sensor Error

Automatic adjustment of 
the display contrast does 
not work.

Contact your distributor.

00250 to 
00259

Bluetooth 
Module Error

Bluetooth cannot be used. Contact your distributor.

00260 to 
00269

System Error The EXPLORER™ 300 
cannot communicate on the 
satellite network.

Contact your distributor.

00270 to 
00279

Voice Module 
Error

Voice services cannot be 
accessed by the 
EXPLORER™ 300

Contact your distributor.

00280 to 
00289

Ethernet 
Module Error

The Ethernet interface on 
the EXPLORER™ 300 
cannot be used.

Contact your distributor.
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00290 to 
00299

Power Supply 
Error

Power on/off, charging 
and/or LED control may be 
out of function.

Contact your distributor.

00300 to 
00309

GPS Module 
Error

The GPS module is out of 
function. The 
EXPLORER™ 300 cannot 
obtain a valid GPS position.

Contact your distributor.

01000 to 
01009

Temperature 
Too Low

Low ambient temperature is 
causing the performance of 
the EXPLORER™ 300 to be 
degraded or halted.

Move the EXPLORER™ 300 
to a warmer location.

For information on 
temperature limits, see 
General specifications on 
page 128.

01100 to 
01109

Temperature 
Too High

High ambient temperature 
is causing the performance 
of the EXPLORER™ 300 to 
be degraded or halted.

Move the EXPLORER™ 300 
to a cooler location.

For information on 
temperature limits, see 
General specifications on 
page 128.

01200 to 
01209

Battery Level 
Low

The battery is running out 
of power.

Recharge the battery or 
replace it with a new one.

01300 to 
01309

No GPS Fix The GPS receiver has not 
yet achieved position fix.

Make sure the view to the 
GPS satellites is not 
blocked. 

To help the 
EXPLORER™ 300 obtain 
GPS fix, it should be placed 
flat on a surface pointing 
straight upwards, with a 
clear view to as much of the 
sky as possible. 

Note that in some cases it 
may take up to 10 minutes 
to obtain GPS fix.

ID Alarm Text Explanation Remedy
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01400 to 
01409

Satellite 
Signal Lost

The EXPLORER™ 300 no 
longer receives a signal 
from the satellite.

Make sure the 
EXPLORER™ 300 has a 
clear view to the satellite.

Check that the antenna is 
pointed according to the 
position data. Adjust the 
position to the highest 
possible signal strength.

01500 to 
01509

SIM Card 
Missing

No SIM card is detected in 
the SIM slot.

Insert SIM card. 

If the SIM card is already 
inserted, try removing and 
reinserting it.

01600 to 
01609

SOS Calls Only The SIM card is not 
accepted by the network. 
Only emergency calls are 
allowed.

Enter the PIN and wait for 
network approval. If the 
problem persists, contact 
your Airtime Provider.

01700 to 
01709

Registration 
For Voice 
Failed

The EXPLORER™ 300 has 
not yet been allowed to 
register for voice services 
(Circuit Switched).

If the problem persists, 
contact your Airtime 
Provider.

01800 to 
01809

Registration 
For Data 
Failed

The EXPLORER™ 300 has 
not yet been allowed 
register for data services 
(Packet Switched).

If the problem persists, 
contact your Airtime 
Provider.

01900 to 
01909

Temperature 
Too Low For 
Charging

The temperature is too low 
for the battery charger to 
operate.

If charging is needed, move 
the EXPLORER™ 300 to a 
warmer location. The 
temperature must be above 
0°C/+32°F for the battery 
charger to operate.

02000 to 
02009

Satellite 
Signal Weak

The signal from the satellite 
is weak.

Check the line of sight to 
the satellite. Be aware that 
window glass may reduce 
the signal level. 

Check that the antenna is 
pointed according to the 
position data. Adjust the 
position to the highest 
possible signal strength.

ID Alarm Text Explanation Remedy
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02100 to 
02109

Ciphering Off The network has turned 
ciphering off.

Do not transmit data that 
requires ciphering.

02200 to 
02209

Ethernet 
Connection 
Failed

Ethernet data session could 
not be established.

See the display call log for 
the cause of the error. Refer 
to Calls menu on page 38.

If the problem persists, 
contact your distributor.

02400 to 
02409

Invalid 
Battery

The EXPLORER™ 300 is not 
able to detect the battery 
type.

The reason may be one of 
the following:

• You are not using an 
original Thrane & 
Thrane battery

• The battery is defective

The EXPLORER™ 300 
requires an original Thrane 
& Thrane battery.

If you are already using an 
original Thrane & Thrane 
battery when you see this 
alarm, contact your 
distributor for support.

02800 to 
02809

Antenna 
Failure

The EXPLORER™ 300 is not 
able to detect the state of 
the antenna relay.

Do not use the terminal. 
Contact your distributor.

02900 to 
02909

Bluetooth 
Device 
Database Full

The list of paired Bluetooth 
devices is full. The 
EXPLORER™ 300 does not 
allow more than 2 paired 
devices.

Unpair a paired device to 
make room for a new one.

For information on how to 
unpair devices, see 
Unpairing devices on 
page 97.

02400 to 
02409

Network failed 
authentication

The EXPLORER™ 300 does 
not accept the network as a 
valid BGAN network.

Restart the 
EXPLORER™ 300.

 If the problem persists, 
contact your distributor.

ID Alarm Text Explanation Remedy
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Log files

Note

When contacting Thrane & Thrane for support, please include a diagnostic report. 
The diagnostic report contains information relevant for the service personnel during 
troubleshooting. 

To generate the diagnostic report, access the web interface and select Help Desk. Then click 
Generate report. 

Alarm log

The alarm log holds information of all alarms issued by the EXPLORER™ 300. 

The log includes the time of the error, a short description, location of the error etc. This 
information can help troubleshooting errors in the EXPLORER™ 300. The Alarm log is not 
accessible from the user interface, but is included when you generate a diagnostic report. For 
information, see Help desk and diagnostic report on page 111. 

Call log

The call log holds information of up to 100 calls and data sessions to/from the EXPLORER™ 300.

The call log contains detailed information such as date, time, phone numbers, duration, Mb 
transferred etc., for each call or data session. 

Date and time is UTC time, received from the satellite.

For information on how to view the call log in the display, see Calls menu on page 38.

For information on how to view the call log in the web interface, see Viewing the lists of calls on 
page 78.

Note The call log in the display shows information on voice calls but not on data sessions.
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Appendix A
Technical specifications A

In this appendix

This appendix contains technical specifications for the EXPLORER™ 300 and information on 
Conformity. 

General specifications

The EXPLORER™ 300 meets or exceeds current and proposed Inmarsat specifications for operation 
on the Inmarsat Broadband Global Area Network.

Item Specification

Type EXPLORER™ 300, BGAN Class 3 Terminal

Max. data ratea

Downlink

Uplink

Streaming IP

a. Performance depends on a wide range of factors and actual usage.

384 kbps (shared)

240 kbps (shared)

32, 64 kbps

Physical dimensions 168 mm x 217 mm x 52 mm/
6.6” x 8.5” x 2.0”

Weight (including Battery) 1.4 kg/3.1 lbs

Environmental conditions

Operating temperature
Powered by external DC
Powered from battery

Storage temperature
Without battery
With battery

Relative humidity

Water & Dust

Max. wind-load

-25°C to +55°C/-13°F to +131°F
0°C to +55°C/+32°F to +131°F

-40°C to +80°C/-40°F to +176°F 
-20°C to +60°C/-4°F to +140°F

95% non-condensing at +40°C/+104°F

IP-54 (dust and spray proof in all directions)

18 m/s or 59 ft/s (Operational)

Robustness 0.5 m/1.64 ft drop on concrete (Operational, 95% survival)

Supported web browsers
(Other browsers may be 
supported as well, but only 
these have been tested.)

Microsoft Internet Explorer 6.0

Mozilla Firefox 1.0

Apple Safari 2.0
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Battery

Specifications

Item Specification

Battery type Lithium ion, rechargeable

Voltage 11.1 V

Capacity 2.2 Ah

Time between recharging

Standby timea

Tx time, max

Rx time, max

Standard callb

a. Performance depends on a wide range of factors and actual usage.
b. With either Bluetooth or Phone interface.

36 hours

1 hour 20 min. @ 96kbps, 0°C to +55°C/+32°F to +131°F

3 hours 30 min. @ 64kbps, 0°C to +55°C/+32°F to +131°F

3 hours, 0°C to +55°C/+32°F to +131°F

Charge timea Less than 3 hours 
(when the EXPLORER™ 300 is switched off)

Charge temperature 0°C to +45°C/+32°F to +113°F Ambient

Min. charge cycles 300

Storage temperature

1 Month

3 Months

1 Year

-20°C to +60°C/-4°F to +140°F Ambient

-20°C to +45°C/-4°F to +113°F Ambient

-20°C to +20°C/-4°F to +68°F Ambient
TT 98-123571-DraftA 129



Appendix A: Technical specifications
Power input

Connector pin-out

This drawing shows the pin-out for the DC Power 
connector.

Specifications

AC/DC adapter, 

SIM interface

Specifications

+

GND

Item Specification

DC input range +10 to +16 V DC

Power consumptiona

Standby mode

Transmit mode

During charging

a. Performance depends on a wide range of factors and actual usage.

0.8 W (Typical)

14 W (Typical)

38 W max.

Connector type 2.5mm EIAJ RC-5320-IV

Item Specification

AC input range 100 to 240 V AC, 47 to 63 Hz

DC output 15 V DC, 50 W

Item Specification

Slot type Standard SIM card holder
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Phone interface

Connector pin-out

The pin-out for the Phone connector is as follows:

Specifications

Pin Function

1 NC

2 Tip

3 Ring

4 NC

1 2 3 4

RJ-11 Connector

Female (Receptacle)

Item Specification

Connector type RJ-11, female

Impedance 180 Ω + 750 Ω/150nF

Max. cable length 100 m/80 Ω

Max. units connected One unit
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LAN interface

Connector pin-out

The pin-out for the LAN connector is as follows:

Specifications

Pin Function

1 Rx +

2 Rx -

3 Tx +

4 NC

5 NC

6 Tx -

7 NC

8 NC

RJ-45 Connector

Female (Receptacle)

Item Specification

Connector type RJ-45, female, MDI-X (IEEE 802.3 10/100BaseT)

Standard ISO/IEC 8877:1992 and 
IEEE 802.3 1998 Edition

Max. data rate 10/100 Mbps

Max. cable length 100 m/328 ft with Cat5 UTP
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Bluetooth interface

Specifications

Item Specification

Version 1.2

Standard Power Class 1. (reduced range: 25 m)
The Class 1 interface also supports Class 2 and Class 3 
peripherals if they support RSSI (Received Signal Strength 
Indicator).

Antenna Integrated in transceiver unit

Physical media Frequency-Hopping Spread Spectrum RF

Max. data rate 721 kbps + 57.6 kbps

Frequency 2400 to 2483.5 MHz

Max. coverage outdoora

a. Performance depends on a wide range of factors and actual usage.

25 m/82 ft 

Max. number of devices 
connected

1 handset and/or one PC/PDA

Profiles supported Cordless Telephony Profile (CTP)

Service Discovery Application

Serial Port Profiles (SPP):

• Dial-up Networking (DUN)

• Headset Profile (HSP)
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Built-in antenna

Specifications

Item Specification

Type Directional patch array, manually adjustable

Polarization RHCP

Frequencies

Inmarsat
Transmit
Receive
Bearer bandwidth

GPS

Bluetooth

1626.5 to 1660.5 MHz
1525.0 to 1559.0 MHz
200 kHz

1575.42 MHz

2400.0 to 2483.5 MHz

EIRP 10 dBW ±1 dB

Power steps 0 to 6 dB in 1 dB steps
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EXPLORER™ Bluetooth Handset charger interface

Connector pin-out

This drawing shows the connector for the EXPLORER™ 
Bluetooth Handset charging interface.

The connector is placed at the back of the 
EXPLORER™ 300. Pin 1 is the pin closest to the coding 
projection on the plastic insert.

Specifications

Pin 1Pin 2

Item Specification

Connector type Proprietary

Output 6.4 V/350 mA
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Serial number label

The following label is placed on the EXPLORER™ 300.

“Xes” are replaced by the relevant numbers for the specific terminal.
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Conformity

CE (R&TTE)

The EXPLORER™ 300 is CE certified (R&TTE directive) as stated in “Declaration of Conformity with 
R&TTE Directive”, enclosed in electronic copy on the next page.

Use of Bluetooth:

Thrane & Thrane have sent notification to all countries in the EU for use of the Bluetooth interface. 
Individual license may be required in some countries outside the EU and USA.

For use in the EU, the following restrictions apply:

• France: Outdoor use must be limited to 10 mW EIRP within the frequency band 2454 MHz to 
2483.5 MHz.

• Italy: Outdoor use outside own premises require general authorization.

FCC

This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions:

1) This device may not cause harmful interference, and 

2) this device must accept any interference received, including interference that may cause 
undesired operation.

Part 15.21
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user's authority to operate the equipment.

GMPCS

The EXPLORER™ 300 has obtained the GMPCS-MoU mark.

Note The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the user's 
authority to operate the equipment.
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AT commands B

In this appendix

This appendix contains a list of AT Commands for the EXPLORER™ 300.

Starting up an AT command session

Set up your computer to use the Bluetooth interface. For further information, see Using a 
computer with Bluetooth on page 63.

Connect your computer to the Bluetooth interface of the EXPLORER™ 300 and launch your 
terminal program.

The following section contains a list of commands that can be used with the EXPLORER™ 300. For 
further information on the AT commands, refer to the following standards:

• ITU V.250 Serial asynchronous automatic dialing and control

• 3GPP TS 27.005 ver. 4.2.0, Use of Data Terminal Equipment - Data Circuit terminating 
Equipment (DTE-DCE) interface for Short Message Service (SMS) and Cell Broadcast Service 
(CBS)

• 3GPP TS 27.007 ver. 4.6.0, AT command set for User Equipment (UE)

3GGP standards are found on www.3gpp.org

ITU standards are found on www.itu.int
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List of supported AT commands

Command Function

ATA Answer

ATD Dial

ATE Command echo

ATH Hang up

ATI Request identification information

ATL Monitor speaker loudness

ATM Monitor speaker mode

ATN Automode control

ATP Select pulse dialing (command)

ATQ Result code suppression

ATS Set register

ATT Select tone dialing (command)

ATV DCE response format

ATX Result code selection and call progress monitoring control

ATZ Reset to default configuration

AT&C Circuit 109 (Received line signal detector) behavior

AT&D Circuit 108 (Data terminal ready) behavior

AT&F Set to factory defined configuration

AT&V Display active and stored profile

AT&W Store profile

AT+CACM Accumulated call meter

AT+CAEMLPP eMLPP priority registration and interrogation

AT+CALM Alert sound mode

AT+CAMM Accumulated call meter

AT+CAOC Advice of charge
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AT+CBC Battery charge

AT+CBST Select bearer service type

AT+CCFC Call forwarding number and conditions

AT+CCLK Clock

AT+CCUG Closed user group

AT+CCWA Call waiting

AT+CCWE Call meter maximum event

AT+CDIP Called line identification presentation

AT+CEER Extended error report

AT+CFCS Fast call setup conditions

AT+CFUN Set phone functionality

AT+CGACT PDP context activate or deactivate

AT+CGATT PS attach or detach

AT+CGCLASS GPRS mobile station class

AT+CGCMOD PDP context modify

AT+CGDATA Enter data state

AT+CGDCONT Define PDP context

AT+CGDSCONT Define secondary PDP context

AT+CGEQMIN 3G quality of service profile (minimum acceptable)

AT+CGEQNEG 3G quality of service profile (negotiated)

AT+CGEQREQ 3G quality of service profile (requested)

AT+CGEREP Packet domain event reporting

AT+CGMI Request manufacturer identification

AT+CGMM Request model identification

AT+CGMR Request revision identification

AT+CGPADDR Show PDP address

Command Function
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AT+CGQMIN Quality of service profile (minimum acceptable)

AT+CGQREQ Quality of service profile (requested)

AT+CGREG GPRS network registration status

AT+CGSMS Select service for MO SMS messages

AT+CGSN Request product serial number identification

AT+CGTFT Traffic flow template

AT+CHLD Call related supplementary services

AT+CHUP Hang-up call

AT+CIMI Request International Mobile Subscriber Identity

AT+CIND Indicator control

AT+CLAC List all available AT commands

AT+CLCC List current calls

AT+CLCK Facility lock

AT+CLIP Calling line identification presentation

AT+CLIR Calling line identification restriction

AT+CMAR Master reset

AT+CMEC Mobile equipment control mode

AT+CMEE Report mobile equipment error

AT+CMER Mobile equipment event reporting

AT+CMGC Send command

AT+CMGD Delete message

AT+CMGF Message format

AT+CMGL List messages

AT+CMGR Read messages

AT+CMGS Send message

AT+CMGW Write message to memory

Command Function
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AT+CMOD Call mode

AT+CMSS Send message from storage

AT+CNMI New message indication to TE

AT+CNUM Subscriber number

AT+COLP Connected line identification presentation

AT+COPN Read operator names

AT+COPS PLMN selection

AT+CPAS Phone activity status

AT+CPBF Find phone book entries

AT+CPBR Read phone book entries

AT+CPBS Select phone book memory storage

AT+CPBW Write phone book entry

AT+CPIN Enter PIN

AT+CPLS Selection of preferred PLMN list

AT+CPMS Preferred message storage

AT+CPOL Preferred PLMN list

AT+CPPS eMLPP subscriptions

AT+CPUC Price per unit and currency table

AT+CPWD Change password

AT+CR Service reporting control

AT+CRC Cellular result codes

AT+CREG Network registration

AT+CRSM Restricted SIM Access

AT+CSCA Service center address

AT+CSCS Select TE character set

AT+CSDF Settings date format

Command Function
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AT+CSIL Silence command

AT+CSMS Select message service

AT+CSQ Signal quality

AT+CSSN Supplementary service notifications

AT+CSTA Select type of address

AT+CSTF Settings time format

AT+CSVM Set voice mail number

AT+CUSD Unstructured supplementary service data

AT+CAAP Automatic answer for eMLPP Service

AT+FCLASS Select mode

AT+GCAP Request complete capabilities list

AT+GCI Country of Installation

AT+GMI Request manufacturer identification

AT+GMM Request model identification

AT+GMR Request revision identification

AT+GSN Request product serial number identification

AT+ICF DTE DCE character framing

AT+IFC DTE-DCE local flow control

AT+ILRR DTE-DCE local rate reporting

AT+IPR Fixed DTE rate

AT+WS46 PCCA STD-101 [17] select wireless network

AT_IBLTH Bluetooth management

AT_IBNOTIFY Control the sending of unsolicited result codes

AT_IBTIF Bluetooth configuration

AT_IBTINQ Bluetooth inquiry management

AT_IGPS GPS location information

Command Function
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AT_ILOG Retrieve log file from the EXPLORER™ 300

AT_IMETER Call metering

AT_INIS Network interface status

AT_IPOINT Antenna pointing

AT_ISIG Signal quality indication

AT_ITCSI Configure incoming voice quality

AT_ITCSO Configure outgoing voice quality

AT_ITEMP Temperature in the EXPLORER™ 300

Command Function
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Glossary
Glossary
A

APN Access Point Name. The Access Point Name is used by the EXPLORER™ 300 user to establish 
the connection to the required destination network. 

B

BGAN Broadband Global Area Network. A satellite network based on geostationary satellites, 
delivering data rates of up to 492 kbps to virtually any part of the earth, with full UMTS (3G) 
compatibility. 

C

CE Conformitée Européenne. This term signifies that a CE certified product conforms to European 
health, environmental, and safety regulations. In short, it makes the product legal to be sold 
in the European Union. 

CID Context IDentifier 

D

DHCP Dynamic Host Configuration Protocol. A protocol for assigning dynamic IP addresses to 
devices on a network. With dynamic addressing, a device can have a different IP address 
every time it connects to the network. 

F

FCC Federal Communications Commission. An independent United States government agency, 
directly responsible to Congress. FCC certification is normally required to make a product 
legal to be sold in the United States. 

G

Geostationary Placed in a fixed position relative to a point on the surface of the earth. 

GMPCS Global Mobile Personal Communications by Satellite. GMPCS is a personal communication 
system providing transnational, regional or global coverage from satellites. 
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GMPCS-MoU A framework signed by Member States, GMPCS System Operators, Terminal Manufacturers 
and Service Providers. The GMPCS-MoU mark allows GMPCS subscribers to take terminals 
anywhere and use them in countries where they are licensed. 

GPRS General Packet Radio Service. A standard for wireless communications which runs at speeds 
up to 115 kbps, compared with current GSM (Global System for Mobile Communications) 
systems’ 9.6 kbps. 

GPS Global Positioning System. A system of satellites, computers, and receivers that is able to 
determine the latitude and longitude of a receiver on Earth by calculating the time difference 
for signals from different satellites to reach the receiver. 

I

IMEI International Mobile Equipment Identity. A unique number given to every single piece of 
mobile phone equipment. IMEI numbers are stored in a database containing all valid mobile 
phone equipment. 

IMSO International Maritime Satellite Organisation. An intergovernmental body established to 
ensure that Inmarsat continues to meet its public service obligations, including obligations 
relating to the GMDSS. 

K

kbps kilobits per second 

L

LAN Local Area Network. A system that links together electronic office equipment such as 
computers and word processors, and forms a network within an office or building. 

LaunchPad LaunchPad is a PC application used to control terminals in the BGAN system. LaunchPad is 
provided on the Inmarsat CD-ROM supplied with your EXPLORER™ 300. Use of the 
LaunchPad is described in the user guide on the CD-ROM. 

M

MAC Media Access Control address. A hardware address that uniquely identifies each node of a 
network. 

MDI-X Medium Dependent Interface. An MDI-X (for MDI crossover) is a version of MDI that enables 
connection between like devices. MDI ports connect to MDI-X ports via straight-through 
cabling. MDI-to-MDI and MDIX-to-MDIX connections use crossover cabling. 
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N

NC Not Connected 

P

Pairing Bluetooth Pairing happens when two Bluetooth enabled devices agree to communicate. The 
two devices exchange passkeys and join what is called a trusted pair. In a trusted pair, the 
two devices automatically accept communication with each other. 

Passkey A unique code or password used when pairing Bluetooth devices. 

PCB Printed Circuit Board 

PDA Personal Digital Assistant. A lightweight, hand-held, usually pen-based computer used as a 
personal organizer. 

PDP Packet Data Protocol. A network protocol used by external packet data networks that 
communicate with a GPRS network. 

PIN Personal Identification Number. A code number used to provide access to a system that has 
restricted access. 

PUK PIN Unblocking Key. An eight-digit code used to unblock a SIM card after three incorrect PINs 
have been entered. The PUK code is supplied with the SIM card. 

R

RSSI Received Signal Strength Indicator 

S

SAS Satellite Access Station. The gateway between the satellites and the worldwide networks such 
as Internet, telephone network, cellular network etc. 

SDU Service Data Unit. Also known as a data packet. 

SIM Subscriber Identity Module.The SIM provides secure storing of the key identifying a mobile 
phone service subscriber but also subscription information, preferences and storage of text 
messages. 

Streaming A technique for transferring data - such as audio or video clips - so that it is processed as a 
continuous stream. With a Streaming connection you are charged by the minute, like for a 
telephone connection. 
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T

TFT Traffic Flow Template. A packet filter list allowing the Core network and the EXPLORER™ 300 
to classify packets received from the external network into the proper PDP context. 

V

VPN Virtual Private Network. A network that is constructed by using public wires to connect nodes. 
You can create networks using the Internet for transporting data, using security mechanisms 
so that only authorized users can access the network. 
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Index
Index
Numerics
2-wire interface

connecting, 51
specifications, 131

A
accessories available, 115
administration settings, 103
advanced configuration

Bluetooth, 93
LAN, 90
network settings, 99

alarms
in display, 45, 122
list of active, 44, 102

antenna
for Bluetooth, 133
pointing, 23
repointing, 39, 74
specifications, 134

APN
setting for all interfaces, 99
setting for Bluetooth, 93
setting for LAN, 90

applications overview, 6
AT commands, 139
audio indicators, 40, 87
automatic power up, 41, 86
Azimuth, 21

B
backlight in display, 39, 86
battery

charging, 113
guidelines for use, 113
inserting, 12
removing, 13
specifications, 129

BGAN
coverage, 2
services, 4
system overview, 3
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Bluetooth devices
pairing, 50, 95
unpairing, 97
viewing list of paired, 97

Bluetooth handset
charging interface, 66, 135
connecting, 52
making a call, 54

Bluetooth interface
connecting a computer, 63
connecting a handset, 52
setting up, 93
setting voice quality, 93
specifications, 133

browser settings
for web interface, 68

C
call log, 38, 85
calls

holding, 58
local, 57
making or receiving, 54
missed, received, outgoing, 38, 78
redial, 56
view ongoing, 73
waiting indication, 57

CE compliance, 137
certification, 137
clearing logs, 105
clearing usage counter, 105
common network settings, 99
compliance, 137
configuration

Bluetooth, 93
exporting to file, 104
import from file, 105
LAN, 90

conformity, 137
connectors

Bluetooth handset charging, 135
LAN, 132
overview, 15
Phone, 131
Power, 130

contact information, 112
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Index
contrast in display, 39, 86
coverage

Inmarsat BGAN system, 2

D
dashboard, 72
data

advanced configuration, 99
Profiles, 106
Traffic Flow Templates, 109

data sessions
view ongoing, 73

delivery
items included, 11

DHCP
enable or disable for LAN, 90

display
backlight, 39, 86
contrast, 39, 86
menu drawing, 31
navigating, 34
overview of menus, 30
short-cuts, 34
symbols, 33

disposal, 114
distributors, 112

E
Elevation, 21
Ethernet interface

connecting, 61
setting up, 90
specifications, 132

EXPLORER™ 300
type number, ii

export configuration, 104

F
FCC compliance, 137
features, 5

G
general specifications, 128
GMPCS compliance, 137
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GPS
antenna, 9
frequency, 134
obtaining GPS fix, 22
position, 42
troubleshooting, 118
view status, 42

H
hardware

view version, 72, 100
Header compression

enable or disable for Bluetooth, 93
enable or disable for LAN, 90

help desk number, 44, 111
changing with web interface, 111

I
IMEI number, 43, 72, 100
import configuration, 105
Inbox for SMS messages

replying, forwarding or deleting, 82
indicators

function, 8
interfaces

turning on or off, 40, 49
interfaces and services

combinations, 10
internal calls, 57
IP address, 43, 72, 100
items included in delivery, 11

L
LAN interface

connecting, 61
setting up, 90
specifications, 132

LaunchPad, 47
LEDs

function, 8
light and sound

disabling, 40, 87
light indicators

function, 8
local phone call, 57
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Index
logs
clearing, 105

M
MAC address, 43, 72, 100
matrix of services and interfaces, 10
messages

configuring outgoing, 83
deleting in display, 36
forwarding, 82
opening in display, 36
opening in web interface, 82
receiving in display, 45
receiving in web interface, 81
replying, 82
sending, 81
view list in display, 36

mobile subscriber numbers
viewing, 43, 72, 100

N
navigation

display and keypad, 34
web interface, 70

number of EXPLORER™ 300 terminal, ii

O
off-line

working with EXPLORER™ 300, 19
options available, 115
Outbox for SMS messages

resending or deleting messages, 80

P
paired Bluetooth devices

view list, 97
pairing Bluetooth devices, 50, 95
phone

local call, 57
making calls, 54
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phone book, 75
add number, 76
delete all entries, 76
delete entry, 76
modify entry, 76

Phone interface
connecting, 51
specifications, 131

PIN
administration PIN, 103
entering in display, 20
entering in web interface, 71
entering with a phone, 53

pointing, 23
help, 21
position data, 21
repoint the antenna, 39
sound on/off, 40, 87

pole mount, 25, 115
POTS interface

connecting, 51
specifications, 131

power, 17
automatic, 41, 86
connecting, 15
specifications, 130

power up mode, 41, 86
Profiles

for data transmission, 106
selecting for Bluetooth, 93
selecting for LAN, 90

properties
view, 43, 72, 100

Proxy server
disabling, 68

PUK code, 20, 53, 71

Q
Quick dial, 54

R
redial, 56
restoring settings, 41

S
safety summary, iii
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Index
semi-fixed installation, 25
sent messages

resending, forwarding or deleting, 80
viewing status, 80

serial number, 43, 72, 100
services

supported by BGAN, 4
services and interfaces

combinations, 10
settings

restore, 41
Short dial, 54
SIM card

inserting, 12
removing, 14
specifications, 130

SMS in display
opening or deleting, 36
receiving, 45
view list, 36

SMS in web interface
forwarding, 82
opening, 82
receiving, 81
replying to, 82
sending, 81

SMS service number, 72, 84, 100
software

uploading, 101
view version, 72, 100

sound
alarm, 40, 87
message, 40, 87
when pointing, 40, 87

sound and light
disabling, 40, 87

specifications
antenna, 134
Bluetooth handset charging interface, 135
Bluetooth interface, 133
Ethernet interface, 132
general, 128
LAN interface, 132
Phone interface, 131
Power, 130
SIM card, 130

Standard data, 60
start-up

options, 18
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status
methods for signaling, 122
viewing, 46, 72

stealth mode
activating, 34
enabling, 40, 87

Streaming data, 60
activating, 37, 60
defining Profiles for, 106

support
contact information, 112

T
telephone interface

connecting, 51
specifications, 131

total usage
viewing, 73, 77

Traffic Flow Templates, 109
troubleshooting guide, 116
type number of EXPLORER™ 300 terminal, ii
typography used in this manual, v

U
unpairing Bluetooth devices, 97
uploading software, 101
usage counter, 73, 77

clearing, 105

V
version

hardware, 43, 72, 100
software, 43, 72, 100

voice mail number
viewing, 43, 84

W
web interface

accessing, 67
browser settings, 68
definition, 67
navigating, 70
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